This textbook has been selected and distributed by Government of Punjab for Academic year 2018-19 as textbook for all Government Schools in Punjab.
"Education is a matter of life and death for Pakistan. The world is progressing so rapidly that without requisite advance in education, not only shall we be left behind others but may be wiped out altogether."

(September 26, 1947, Karachi)

Quaid-e-Azam
Muhammad Ali Jinnah
Founder of Pakistan

Publishers Note
This book is being published in accordance with the National Textbook Policy 2006 and National Textbook and Learning Materials Policy 2007 as per international standards. This book has been selected by Government of Punjab for prescription and distribution in all the Government schools in Punjab. Suggestions are requested for the improvement of this book by pointing out any error in spellings, contents, etc.
Contents

Unit 1: Introduction to Computers
1.1 What is a Computer? 1
1.2 Components of a Computer 2
1.3 How a Computer works? 5

Unit 2: Introduction to Windows
2.1 Stepping into Windows 19
2.2 Working with Windows 29
2.3 Managing Files and Folders 30

Unit 3: Commonly Used Software
3.1 Working with Paint 37
3.2 Using a Typing Tutor 41
3.3 Working with Word 59
3.4 Using Media Player 60

Unit 4: The Internet and World Wide Web
4.1 Introduction to Internet 74
4.2 The World Wide Web 81

Answers 99
Glossary 115
Bibliography 116
Index 122

Date of Printing 136
Edition 138
Impression 140
No of Copies 141
Price 67.00
INTRODUCTION TO COMPUTERS

Computer is a machine that helps us in our daily life. In this unit, students will learn the definition of a computer, advantages of using a computer, data and information used in a computer. They will also learn about input, processing, output, and storage devices and operations.

Learning Outcomes:
After completing this unit, students will be able to:

- define Computer
- define Data and Information
- explain the advantages of using computers
- define Hardware and Software
- know the difference between Hardware and Software
- know Input Devices
- know System Unit
- know Storage Devices
- know Output Devices

- know Communication Devices
- know how a computer works
- describe four basic operations performed by a computer
1.1 What is a Computer?

When someone says the word “computer”, you may think of a machine that looks like this...

![Personal Computer](image)

A **computer** is an electronic machine which processes raw data (input) into meaningful information (output), and also stores output for later use. It always performs according to the given instructions.

There are different categories of computers. Some of them are given below:

![Tablet PC](image)  ![PDA](image)  ![Smart Phone](image)  ![Palmtop](image)

![Personal Computer](image)  ![Notebook/Laptop](image)  ![Super Computer](image)

*Fig. 1.1b Different Categories of Computer*
1.1.1 Data and Information

A collection of facts and figures (unprocessed items) is known as Data. It can be in the form of a text, numbers, images, audio and video.

Data after processing is called information. Information is basically a meaningful data easily understandable by people.

**Processing** is an action in which computer converts Data into Information.

Data is processed into information by a computer. In this example student's name, address, subjects and marks obtained in each subject represent data. The computer processes this Data and turn it into Information in the form of the grade certificate.
1.1.2 Advantages of Using Computers

There are several advantages and benefits of using computers. Some of them are discussed below:

- **Speed**
  
  *Speed* is the most important characteristic of a computer. The computer can perform billions of calculations in a fraction of a second. For example, if a student is asked to calculate the following product.

  \[
  \begin{array}{c}
  9836572 \\
  \times \quad 68935
  \end{array}
  \]

  The student will take few minutes to solve it, but a computer can solve millions of such problems in less than a second.

- **Accuracy**
  
  Computer is almost 100% accurate and it never makes mistakes. In the above example, there is a chance that the student can make errors while solving it but a computer never does so.
  
  Computer gives wrong results only when defective data or instructions are given.

- **Diligence**
  
  Besides being fast, a computer can do things over and over again. It never gets tired or bored. If we have to write a letter 100 times we will get tired. A computer can write the letter even a million times but never gets tired or bored.

- **Storage**
  
  Computers have large storage capacity. A computer can store very large amount of data. A large building is required to store thousands of books. But a computer can easily store thousands of books in its memory.

- **Versatility**
  
  *Versatility* is the key benefit of using computers. A user can perform variety of tasks with a computer like drawing pictures, writing stories, watching movies, playing games, etc.
1.2 Components of a Computer

A computer has different components to perform a variety of tasks. Hardware and Software are the main components of a computer.

Hardware

Hardware refers to all physical parts of a computer that we can see and touch. This includes the input and output devices as well as the system unit.

![Computer Hardware](image)

Software

A computer cannot perform a task with hardware alone. It needs software too. Software is the set of instructions given to the computer to perform a specific task.

For example, the games we play and the programs we run on a computer i.e. Windows XP, Microsoft Word, Microsoft Paint, etc. are software.

![Software](image)
1.2.1 Difference Between Hardware and Software

Following is a table that describes some differences between hardware and software.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware refers to all physical parts of a computer that we can see and touch.</td>
<td>Software is the set of instructions given to the computer to perform a specific task.</td>
</tr>
<tr>
<td>Hardware is like a human body.</td>
<td>Software is like a human soul.</td>
</tr>
<tr>
<td>Some examples of hardware are Monitor, Keyboard, Mouse, Printer, System Unit, Scanner, Motherboard, Speakers, etc.</td>
<td>Some examples of software are Microsoft Windows, MS Word, MS Paint, Media Player, Internet Explorer, etc.</td>
</tr>
</tbody>
</table>

1.2.2 Input Devices

Devices that are used to enter data into a computer are called input devices. The widely used input devices are the keyboard, mouse, microphone, scanner and digital camera.

Keyboard

Keyboard is the most commonly used input device. It allows a user to type alphabet, numbers or symbols into the computer. It has small buttons called keys. The keys are laid out in the QWERTY pattern. Now look at the keyboard again Q W E R T Y are the letters on the top left of the keyboard.
A standard keyboard can be divided into following sections.

- Function Keys
- Alphanumeric Keys
- Numeric Keypad
- Cursor Control/Navigation Keys

**Function Keys**
The Function keys are located at the top of the keyboard. The purpose of these keys is based on the software we are using. For example, pressing the F1 key opens the Help screen in Windows.

**Alphanumeric Keys**
Alphanumeric keys are the collection of letters, numbers and punctuation keys. This section also includes some special keys, the Tab, Caps Lock, Back Space, Enter, Shift, Ctrl and Alt keys.

**Numeric Keypad**
The numeric keypad is usually located on the right side of a standard keyboard. This section contains digit keys and mathematical operator keys (+, -, *, /).

**Cursor Control/Navigation Keys**
Cursor control keys consist of Arrow keys, Insert, Delete, Home, End, Page Up, and Page Down keys. These keys are used to move cursor within the text.
# Components of a Computer

## Important Keys and their Functions

<table>
<thead>
<tr>
<th>Keys</th>
<th>Functions</th>
<th>Keys</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Tab key lets you move the cursor more than one space at a time.</td>
<td>Delete</td>
<td>Delete key is used to erase a letter or number typed incorrectly.</td>
</tr>
<tr>
<td>Esc</td>
<td>Escape key is used to terminate any process in between.</td>
<td>Backspace</td>
<td>Backspace key is used to erase a letter or number to the left of the cursor.</td>
</tr>
<tr>
<td>Caps Lock</td>
<td>Press the Caps Lock key when you want to write a word in capital letters.</td>
<td>Home</td>
<td>Home key moves the cursor to the beginning of the line or screen.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>These keys do not work on their own. They are used in combination with another key. For example: Ctrl + O = Open a new file. Alt + F4 = Close any program/window.</td>
<td>End</td>
<td>End key moves the cursor to the end of the line or screen.</td>
</tr>
<tr>
<td>Alt</td>
<td></td>
<td>Shift</td>
<td>Shift keys are used: 1) to type capital letters. 2) to type symbols.</td>
</tr>
<tr>
<td>Enter</td>
<td>Enter key is used: 1) to start a new line 2) to execute a command</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Mouse

The mouse is an input device that enables a user to select commands quickly and perform tasks. It has two (sometimes three) buttons to click on.

As the mouse moves, the arrow on the screen will move at the same time. This arrow is called the mouse pointer.
**Mouse Actions**

**Click:** Quickly pressing and releasing the mouse button once is called click.

- Clicking on the left mouse button will highlight the icon.
- Clicking on the right mouse button will display a shortcut or quick menu.

**Double Click:** Quickly pressing and releasing the left mouse button twice is called double click. This method is used to open a folder or run a program.

**Dragging:** To press and continue to hold down the left mouse button and move the mouse is called dragging.

**Drop:** After dragging, releasing the left mouse button to move an object is called drop.
**Scanner**

A **Scanner** is an input device. It is used to scan text and images into the computer. Once a document or picture is scanned, it can be displayed on the screen of the computer.

It works like a photocopy machine. It creates a copy of document or image in the computer.

![Scanner Diagram](image)

Fig. 1.2.2c Scanning Process

**Digital Camera**

A **digital camera** is an input device. It allows a user to take pictures and make videos, then store them in the computer instead of a traditional film. You can see a picture on the screen of the camera. Digital cameras have built-in memory to store images. Digital camera provides a feature to delete and edit an image after taking it.

You can view the picture on the LCD of your digital camera.

![Digital Camera Diagram](image)

Taking Picture

Sending picture to the computer.

![Sending Picture](image)

Fig. 1.2.2d Digital Camera
**Components of a Computer**

**Microphone**

A microphone is an input device. It is used to input audio in the computer. We can record voice using microphone in the computer. Microphones are used to make audio and video calls and chat over the internet.

**1.2.3 System Unit**

System unit is a box which consists of different electronic components. These components are main circuit board, processor, power supply, storage devices, etc.

**System unit can be found in different shapes and sizes.**
Components of a Computer

Unit - 1

**Motherboard**

Motherboard is the largest circuit board in a computer. It is also known as the System board. All computer components are plugged or connected with it. Following are some of the computer components attached to the motherboard.

- Processor
- Memory Chips
- Input/Output devices
- Storage devices, etc.

![Motherboard Image](image)

**Processor**

Processor is the brain of a computer. It is made of a silicon chip fixed on the motherboard. Its primary job is to carry out a set of instructions and process data efficiently and accurately. It converts data into information. It is also called CPU (Central Processing Unit).

![Processor Image](image)
Components of a Computer

Unit - 1

Memory

Memory is an electronic holding place. It holds instructions and data that a computer’s processor can access. Usually, the term ‘memory’ refers to the RAM (Random Access Memory). RAM is the temporary storage area for the data, before and after it is processed. RAM is also known as volatile memory. It means that RAM loses data when power is switched off. It is a high-speed memory.

How to Find Processor Speed and Memory Size of the Computer?

⇒ Right click the My Computer icon on the Desktop.

⇒ Click Properties.

⇒ System Properties dialogue box appears.

⇒ Computer’s general information appears showing Processor speed and Memory size.

⇒ Now write down the Processor speed and Memory size of your computer.

Processor Speed

Memory Size

Fig 1.2.3e RAM

Fig 1.2.3f System Properties dialogue box
1.2.4 Storage Devices

In a computer, storage devices hold data, instructions and information permanently. Storage devices have a much larger capacity to store data. Some common examples of storage devices are Floppy disk, Hard disk, CDs/DVDs and USB flash memory.

Floppy Disk

Floppy disk is a portable and inexpensive storage device. It consists of a flexible thin magnetic film. This film is enclosed in a plastic case. A standard floppy disk is 3.5" inches wide.

A floppy disk drive is used to read and write data from floppy disk. Nowadays, it is rare to find floppy disk drives in modern computers. Floppy disks are not widely used due to their low storage capacity.

Hard Disk

Hard disk is the permanent storage device of a computer. It is also called a Hard disk drive or Hard drive. It is a reliable and durable storage device. It is fixed inside the System Unit.

Hard disk consists of several rotating disks called platters. Each platter stores data. They are sealed in an airtight case to keep them free from dust. It can store very large amount of data and information.
Components of a Computer

Unit - 1

Nowadays, external hard disks are also available in the market.

Fig. 1.2.4c External Hard Disks

CD / DVD

CD/DVD is a portable and comparatively less reliable storage device than a Hard disk. They are flat and round discs made of plastic. A CD/DVD has a thin layer of material that reflects light easily. The CD/DVD drives use a laser beam to read from and write data on them. CD/DVD are used to store software, data, pictures, movies, music and video games.

CD stands for Compact Disc.

A CD can run in CD drive and DVD drive too.

Quality of sounds and movies is low in a CD.

DVD stands for Digital Versatile/Video Disc.

A DVD can only run in a DVD drive.

Quality of sounds and movies is high in a DVD.

Fig. 1.2.4d CD/DVD
**USB Flash Memory**

USB Flash memory is a storage device. It is also known as Data Traveller. It is plugged in the USB port of the computer. It is a portable, inexpensive, reliable and durable storage device.

Flash memory is small and lightweight. It consists of a memory chip. We can read from and write data on the flash memory. It is widely used to transfer data from one computer to another.

![USB Flash Memory](Fig. 1.2.4e USB Flash Memory)

### 1.2.5 Output Devices

Once the data is processed, it can be displayed in different ways. Devices that show/generate output are called output devices. Monitors, printers and speakers are some of the output devices.

**Monitor**

Monitor is an output device. It displays information on the screen. It is the main device to see results (output). It is also known as VDU (Visual Display Unit). The output which is displayed on the monitor screen is called soft copy. There are different types of monitors. Some of them are shown below.

- **CRT monitor**
  - CRT (Cathode Ray Tube) monitors are heavier, need more space and produce small amount of radiation.

- **LCD monitor**
  - LCD (Liquid Crystal Display) are light, flat and do not need much space. It does not produce radiation.

- **Plasma monitor**
  - Plasma monitors are recent development, and show richer colors than LCD and CRT monitors.

![Different Types of Monitors](Fig. 1.2.5a Different Types of Monitors)
Printer

Printer is an output device. It gives output on the paper. The printed output is called hard copy. The most common types of printers are laser, ink-jet and dot matrix printers.

Dot Matrix Printer
Dot matrix printer prints by arranging dots on a paper. The quality is not very good but the printing cost is less. It produces a noise during printing.

Ink-Jet Printer
An ink-jet printer has a print head that sprays tiny ink drops on a paper. It is better for smaller jobs and colour images. These printers are popular for home usage.

Laser Printer
The laser printer is especially suited for printing large number of pages. It is quick, silent and produces a high quality print.

Fig. 1.2.5b Printers

Speaker

Speakers are output devices. They allow us to hear different sounds. Some computers have small internal speakers.

Fig. 1.2.5c Speakers
1.2.6 Communication Devices

The devices which are used to communicate and connect a computer with other computers are known as communication devices.

Modem

A modem is a device which is used to connect and communicate with other computers on the Internet. It sends and receives data. There are two types of modems.

Internal Modem
Placed inside the System Unit

External Modem
Placed outside the System Unit

Fig. 1.2.6 Modems
### 1.3 How a Computer Works?

The way a computer works is very much similar to the way human beings solve their problem using paper and pencil. There are four basic operations performed by a computer i.e. Input, Processing, Output and Storage.

<table>
<thead>
<tr>
<th></th>
<th>You</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input</strong></td>
<td>You read a question. 3x6=?</td>
<td>Computer receives numbers from the keyboard. 3x6=9</td>
</tr>
<tr>
<td><strong>Processing</strong></td>
<td>You think about the question and solve it. 3x6=18</td>
<td>Computer works on the numbers.</td>
</tr>
<tr>
<td><strong>Output</strong></td>
<td>You write answer on a paper.</td>
<td>Computer shows result on a monitor.</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>You can save your work in a bag to use it later.</td>
<td>Computer can use disks, CDs and DVDs to store data.</td>
</tr>
</tbody>
</table>
How a Computer Works?

Input Operation
In this operation, the computer accepts data and instructions from input devices. The input devices include keyboard, mouse, scanner, digital camera, microphone, etc.

Processing Operation
The operation in which a computer performs some action on the data according to the instructions is known as processing operation. The processing is done by the Central Processing Unit (CPU).

Output Operation
In this operation, the computer uses output devices to produce results of the processing (information). It may be either displayed on the screen or printed on the paper. Audio output is produced by speakers of the computer.

Storage Operation
In this operation, the computer stores the data/information on different storage devices such as Hard disk, Floppy disk, CD/DVD and Flash memory.

Fig. 1.3 Basic Operations of a Computer
**Summary**

- **Computer** is an electronic machine which processes raw data (input) into meaningful information (output), and also stores output for later use.
- Computer can help us in our work. It helps us to write text, solve problems, count, draw paintings, etc.
- Collection of facts and figures is known as **Data**.
- Data after processing is called **Information**.
- **Hardware** refers to all physical parts of a computer that we can see and touch.
- **Software** is the set of instructions given to the computer to perform a specific task.
- Devices that are used to enter data into a computer are called **input devices**.
- **Keyboard** is most commonly used input device. It allows a user to type words, numbers or symbols into the computer.
- **Mouse** is an input device that enables a user to select commands quickly and perform tasks.
- Quickly pressing and releasing the mouse button once is called **click**.
- Quickly pressing and releasing the left mouse button twice is called **double click**.
- To press and continue to hold down the left mouse button as you move the mouse is called **dragging** the mouse.
- **Scanner** is used to scan text and images into a computer.
- **Digital Camera** allows a user to take pictures and store them in a computer instead of a traditional film.
- **Microphone** is an input device. It is used to input audio in a computer.
- **System unit** is a box which contains different electronic components of the computer e.g. motherboard, processor, power supply, etc.
- **Motherboard** is the largest circuit board in the computer. All computer components are plugged or connected with it.
- **Processor** is the brain of a computer. Its primary purpose is to carry out a set of instructions and process data efficiently. It is also known as CPU.
- **Memory** is the electronic holding place. It holds instructions and data that a computer’s processor can access.
- **Storage devices** hold data, instructions and information permanently.
- **Floppy disk** is a portable and inexpensive storage device.
Introduction to Computers

- **Hard disk** is a permanent storage device of a computer. It is an inexpensive, reliable and durable storage device. It is fixed inside the system unit.
- **CD/DVD** is a portable, inexpensive and comparatively less reliable storage device than a hard disk. These are flat and round discs made of plastic.
- A **USB Flash memory** is a storage device. It is a portable, inexpensive, reliable and durable storage device.
- Once the data is processed, it can be displayed in different ways. Devices that generate/show output are called **output devices**.
- **Monitor** is an output device. It displays information on the screen.
- **Printer** is an output device. It gives output on paper. The printed output is called hard copy.
- **Speakers** are output devices. They allow us to hear sounds from a computer.
- **Communication devices** are used to communicate and connect a computer with other computers.
- **Modem** is a device which is used to connect and communicate with other computers on the Internet.
- The operation in which a computer accepts data and instructions for processing from input devices is known as **input operation**.
- The operation in which a computer performs some action on the data according to the instructions is known as **processing operation**.
- In an **output operation**, the computer uses output devices to produce the results of the processing (information).
- In a **storage operation**, the computer stores data/information on different storage devices such as Hard disk, Floppy disk, CD/DVD and Flash memory.

**Exercise**

Q.1 **Tick the right choice.**

i) ___________ can consist of text, numbers, images, audio and video.

a) Data  

b) Delta  

c) Date  

d) Delta
ii) Meaningful data is known as ________________________.
   a) Calculation  b) Information  c) Evaluation  d) Situation

iii) Hardware are the_______________________ parts of a computer.
   a) Logical  b) Physical  c) Conceptual  d) Technical

iv) Which of the following is the example of software?
   a) Monitor  b) Keyboard  c) Microsoft Windows  d) CD/DVD

v) In the standard keyboard, keys are laid in _______________pattern.
   a) QWARTX  b) QERWYT  c) QWERTY  d) QWERTY

vi) Mouse is an______________________________ device.
   a) Output  b) Input  c) Storage  d) Communication

vii) Which of the following is not an input device?
   a) System Unit  b) Mouse  c) Keyboard  d) Scanner

viii) ________________ is used to take pictures and store them in the computer.
   a) Mouse  b) Keyboard  c) Digital Camera  d) Scanner

ix) ________________ is an input device used to record voice in a computer.
   a) Microphone  b) Scanner  c) Digital Camera  d) Monitor

x) Which of the following is not placed in System Unit?
   a) Motherboard  b) Hard disk  c) RAM  d) Printer
Introduction to Computers

Unit - 1

xi) CPU stands for ________________.
   a) Central Population Unit       b) Central Processing Unit
   c) Central Publishing Unit       d) Control Processing Unit

xii) Hard disk is a ________________ storage device.
    a) Temporary                   b) Permanent
    c) Primary                     d) Portable

xiii) Monitor is an ________________ device.
      a) Processing                  b) Output
      c) Storage                     d) Input

xiv) A ________________ gives output on the paper.
     a) Scanner                      b) Microphone
     c) Mouse                        d) Printer

xv) There are ________________ basic operations performed by a computer.
    a) Five                          b) Three
    c) Four                         d) Two

Q.2 Fill in the blanks.

i) Computer follows ________________ to perform any task.

ii) ________________ that you put into a computer are known as data.

iii) Computer games are example of the ____________________________

iv) ________________ click of the left mouse button is used to select an item.

v) Microphone is an ________________ device.

vi) Motherboard is also known as ____________________________

vii) ________________ disk are rarely found nowadays.

viii) DVD stands for digital ____________________________ disk.
Introduction to Computers

Unit - 1

ix) A computer performs input, processing, ___________ and storage operations.

x) In ________________ operation, data turns into information.

Q.3 Define the following.

i) Computer

ii) Memory

iii) Software

iv) Hard disk

v) Motherboard

vi) Processing operation

Q.4 Differentiate between the following.

i) Data and Information

ii) Single click and Double click

iii) Hardware and Software

iv) CD and DVD

v) Input devices and Output devices

vi) Input operation and output operation

Q.5 Give brief answers to the following questions.

i) Write five advantages of using computers.

ii) What is hardware? Write the names of five hardware devices.

iii) Write functions of the following keyboard keys.

a) Tab

b) Esc

c) Enter

d) Shift

e) Caps Lock

iv) What does a processor do?

v) What is memory? Is it a temporary storage device?

vi) Write a short note on Hard disk.

vii) Write advantages of USB Flash memory.

viii) Explain different types of Monitors.

ix) What is a modem? Explain its different types.

x) Explain the output operation of a computer.
Q.6 Match column A with column B and write the numbers of matching pairs in column C.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>i) Software</td>
<td>a) Keyboard</td>
<td></td>
</tr>
<tr>
<td>ii) Input devices</td>
<td>b) Speakers</td>
<td></td>
</tr>
<tr>
<td>iii) Audio output</td>
<td>c) Permanent storage</td>
<td></td>
</tr>
<tr>
<td>iv) Monitor</td>
<td>d) Produce results</td>
<td></td>
</tr>
<tr>
<td>v) RAM</td>
<td>e) Terminate the program</td>
<td></td>
</tr>
<tr>
<td>vi) Modem</td>
<td>f) Windows XP</td>
<td></td>
</tr>
<tr>
<td>vii) Hard disk</td>
<td>g) Physical parts</td>
<td></td>
</tr>
<tr>
<td>viii) Printer</td>
<td>h) Communication device</td>
<td></td>
</tr>
<tr>
<td>ix) Esc key</td>
<td>i) Dot matrix</td>
<td></td>
</tr>
<tr>
<td>x) Output operation</td>
<td>j) LCD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>k) Memory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>l) Power supply</td>
<td></td>
</tr>
</tbody>
</table>

Q.7 Label the following keyboard.
Lab Activity (Keyboard)

For each item below, fill in the symbol that would be entered.

<table>
<thead>
<tr>
<th>Shift +</th>
<th>1</th>
<th>!</th>
<th>Shift +</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift +</td>
<td>2</td>
<td></td>
<td>Shift +</td>
<td>7</td>
</tr>
<tr>
<td>Shift +</td>
<td>3</td>
<td></td>
<td>Shift +</td>
<td>8</td>
</tr>
<tr>
<td>Shift +</td>
<td>4</td>
<td></td>
<td>Shift +</td>
<td>9</td>
</tr>
<tr>
<td>Shift +</td>
<td>5</td>
<td></td>
<td>Shift +</td>
<td>0</td>
</tr>
</tbody>
</table>

Lab Activity (Drag and Drop)

Practice this method by arranging the icons on the desktop to form the first letter of your name.

Lab Activity (Motherboard)

Write the names of computer components which are attached with your computer.

1) __________________________  2) __________________________
3) __________________________  4) __________________________
Lab Activity (Scanning)

Scan the following objects and set it as a wallpaper on your computer. Get the help of your teacher for this activity.

Signatures of Quaid-e-Azam Muhammad Ali Jinnah

Lab Activity (Storage Devices)

Discuss with your teacher about the following qualities of Storage Devices. Choose one of the following options.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Floppy disk</th>
<th>Hard disk</th>
<th>CD</th>
<th>DVD</th>
<th>Flash Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expensive medium</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reliable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Durable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High Storage Capacity</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Lab Activity (Monitor)

What type of display device do you have in the computer lab of your school and at your home?
Microsoft Windows is a program that controls the overall activity of a computer. It provides ways to organize and manage files stored into a computer. A user can use Windows to sort, copy, move, delete and view the files. It controls the basic operations of a computer. Windows controls different parts of your computer system such as printer and monitor, and also enables them to work together.

Learning Outcomes:

After completing this unit, students will be able to:

- know the start up procedure to step into Windows
- know the following parts of the Windows
  - Desktop, Start button and Start menu
  - Taskbar and Notification area
  - Desktop icons
- open a window from the following locations
  - Desktop
  - Start menu
  - Run command
- get familiar with functions of the following on a window
  - Title bar, Menu bar, Scroll bar
  - Status bar and Toolbar
  - Maximize and Minimize buttons
  - Close button
- define a File, Folder and Drive
- copy a File/Folder to the Desktop
- move a File/Folder to the Desktop
- drag a File/Folder to the Desktop
- delete a File/Folder
2.1 Stepping into Windows

Microsoft Windows is the software which provides a platform to work on a computer. We can only work on a computer if there is a software like Windows.

Following are the steps of the start up procedure of Windows.

→ Start your computer by pressing “power” button on the System box.

![Switch on a Computer](image)

**Fig. 2.1a Switch on a Computer**

→ Windows XP starts loading its files into the computer.

![Windows XP Professional](image)

**Fig. 2.1b Windows loading its files**
After successfully loading, Windows logs on and a welcome screen appears.

You can log on to computer by clicking user name and typing password (if assigned) in the text box, as in Fig. 2.1c.

Fig. 2.1c Welcome Screen

Windows Desktop screen appears.

Fig. 2.1d Windows Desktop
2.1.1 Desktop

The main screen of the Microsoft Windows is known as desktop. The desktop contains icons of different files and programs, so a user can easily access them. All programs, windows and dialog boxes open on the desktop. It is the working area of Microsoft Windows.

2.1.2 Start Button and Start Menu

At the bottom left corner of the screen there is a Start button. This button displays a list of items called Start Menu. Different versions of Windows have different Start buttons i.e.

When a user clicks the Start button, a menu appears that lets the user easily access most useful items on the computer. Start menu gives a complete control of the computer under one menu.
Always remain in Start menu.

The white area of the Start menu is user-based.

List of frequently used programs.

The light blue area of the Start menu is Windows-based.

A user can turn off computer by clicking this button.

A user can log off by clicking this button.

Users can access all programs installed in the computer by clicking “All Programs” on Start menu.

### 2.1.3 Taskbar

*Taskbar* is placed at the bottom of the screen (Fig 2.1.1a) in the *Microsoft Windows*. It includes *Start button, Quick Launch toolbar, Taskbar buttons and Notification area*. Users can access Start menu and different programs from Start button and quick launch toolbar. Users can also switch between programs and windows by clicking their buttons on the taskbar.

Start button | Quick Launch toolbar | Taskbar buttons of currently running programs | Notification area
---|---|---|---

![Fig. 2.1.3 Taskbar](image)

### 2.1.4 Notification Area

The area at the bottom right on the screen is known as *Notification area*. It is a part of the *taskbar*. It shows different notifications of the events that occurs in *Windows*. 
It also displays Time and different program icons such as Volume Control, Windows Firewall, and Anti-Virus, etc. It also shows temporary icons such as USB device and Printing, etc.

### 2.1.5 Desktop Icons

Icons are small images that represent different types of programs and files. Desktop contains different types of icons. Following are the main four icons of the desktop.

#### My Documents

My Documents icon represents My Documents folder. It is used to save documents such as letters, reports, pictures and media files. By default there are three folders in the My Documents folder, My Music, My Pictures and My Videos.

1. Double click the icon of My Documents from the desktop.
2. My Documents window appears.

*Fig. 2.1.5a My Documents Folder*
My Computer

My Computer icon helps a user to access all disk drives and other hardware connected to the computer. It shows icons of different users, documents, disk drives such as Hard disk, CD/DVD, Floppy and USB Flash memory.

→ Double click the icon of **My Computer** from the desktop.

→ My Computer window appears.

![My Computer](image_url)

**Fig. 2.1.5b My Computer**

Recycle Bin

Recycle Bin is the place where Windows stores deleted files. User can restore any deleted file from Recycle Bin if it has been deleted by mistake. On the other hand, a user can empty the Recycle Bin to create more disk space.

→ Double click the icon of **Recycle Bin** from the desktop.
Internet Explorer

A user can access Internet Explorer by clicking its icon on the desktop. Internet Explorer can be used to search and view information on the World Wide Web.

- Double click the icon of Internet Explorer from the desktop.
- Internet Explorer window appears.
2.2 Working with Windows

Microsoft Windows provides a platform to work on a computer. A user can easily access programs and windows using different ways in Windows. There are three different ways to open a program/window.

- From Desktop
- From Start Menu
- From Run Command

Opening Paint Program from Desktop

→ Double Click on the icon of Paint.

→ MS Paint window appears.
Opening Paint from Start Menu

1. Click Start button.
2. Start menu appears.
3. Point to All Programs → Accessories.
4. Click Paint.

Fig. 2.2c Start Menu

Opening Paint from Run Command

1. Click Start Button.
2. Start menu appears.
3. Click Run.

Fig. 2.2d Start Menu
Unit - 2

Run dialog box appears.

Type the program name and path here.

Click OK.

MS Paint window appears.

2.2.1 Get Familiar with a Window

A rectangular area on the computer screen in which an application or document is viewed and accessed is known as a window. A window allows a user to work easily with multiple programs. User can minimize, maximize, hide, resize and view a window. A window and its different parts are shown below.

Fig. 2.2.1a My Documents window
Title Bar
The horizontal bar at the top of a window is known as Title bar. It contains the name of the window/application and its icon at left corner and control buttons (maximize, minimize and close) at the right corner.

Menu Bar
The Menu bar is located under the Title bar on a window. A Menu bar of a window contains different menus such as File, Edit, View, Favorites, Tools and Help. These menus contain all the commands regarding the application/window.

Toolbar
A Toolbar is situated under the Menu bar of a window. It contains different command buttons with their icons so a user can easily access these commands.

Status Bar
Status bar gives information about the window and its contents. It is usually located at the bottom of a window. Not all windows have a status bar.

Scroll Bar
Scroll bar is used to view all the contents of a window vertically and horizontally. It appears when the contents of a window do not fit in its size.
Vertical scroll bar appears on the right side of the window. Horizontal scroll bar appears at the bottom of the window.

Control Buttons
The buttons on the top right corner of a window are known as control buttons. They consist of Minimize, Maximize and Close buttons.

Minimize Button
Minimize button is used to reduce a window to a button on the taskbar. A user can re-display the window at any time by clicking the button on the taskbar.

Close Button
Close button is used to close an open window or application.

Maximize/Restore Button
Maximize button is used to enlarge a window to full screen. It is also known as Restore button because it restores a maximized window to its previous size.
2.3 Managing Files and Folders

One of the main features of Microsoft Windows is to manage files and folders. Computer stores data in the form of files. Files are organized in the folders. These files and folders are stored in the drives such as Hard disks, CD/DVD and Flash memory. A user can easily store and retrieve data with the use of files and folders.

File

A file is a collection of data that is stored in a computer. There are different types of files such as text files, graphic files, sound files and program files, etc. Files can be stored in various storage devices such as Hard disk, Flash memory drive, CD and DVD drives.

A file consists of two parts: name and type. Suppose you want to save the picture of your friend and give it a name "picture". Computer will save it as picture.jpg.

Folder

Folders are like envelopes or drawers in which a user can place data. A folder can contain files and even other folders. They are used to organize data.
Importance of Folders

Suppose, Ali is looking for his Math book from a big pile of books. He will have to sift through the pile of books to find Math book. The same thing can happen if someone does not use folders to store data.

Ali can arrange books in the bookshelves.

- Shelf 1: Islamiyat books
- Shelf 2: Urdu books
- Shelf 3: English books
- Shelf 4: Math books
- Shelf 5: Science books

When Ali wants to look for a particular book, it is now much easier to find because they have been organized into several categories. Similarly, data in a computer can be organized in the same way with the help of folders.

Several folders can be created in the computer. For example:

- Math folder contains files related to Mathematics.
- English folder contains files related to English.
- Computer folder contains files related to Computer.
- Science folder contains files related to Science.
Drive
A storage area in any storage device is known as drive. Drives are named by a letter followed by a colon (such as C:). The storage device can be a Floppy disk, a CD/DVD, a Hard disk and a USB Flash memory.

Open My Computer.

Fig. 2.3 My Computer Window

CD drive

In this window user can access and get information about all disc drives and other hardware connected to the computer.

2.3.1 Creating a Folder
When a user wants to sort and manage files and data, he/she creates a new folder. There are different methods of creating a new folder in Microsoft Windows.

Creating a Folder using Right Click Menu

Right click anywhere on the desktop.
Managing Files and Folders

Unit - 2

Right click menu appears.

Move mouse over NEW.

Click the Folder option.

The new folder appears, displaying a temporary name (New Folder).

Type a name for the new folder (for example, My Work) and press enter.

A folder with the name My Work has been created on the Desktop.

Create a Folder from File Menu

Open My Documents folder.

Click File menu.

Move mouse over NEW.

Click the Folder option.

A File/Folder name can contain up to 255 characters, including spaces. But, it can't contain any of the following characters: / \ : * ? < > |
The new folder appears, displaying a temporary name (New Folder).

Type a name for the new folder (for example, My Work) and press .

A folder with the name My Work has been created in My Document folder.

Creating a Folder from File and Folder Tasks Pane

Open My Documents folder.

Click on Make a new folder in the File and Folder Tasks pane.

The new folder appears, displaying a temporary name (New Folder).

Type a name for the new folder (for example, My Work) and press .

A folder with the name My Work has been created in My Documents folder.
2.3.2 Creating a Blank File

A blank new File can also be created by using the File Menu.

Creating a blank file from File Menu

1. Open My Work folder in the My Documents (Which you have just created).
2. Click File menu.
3. Move mouse over NEW.
4. Click the Text Document option.

A new text file appears, displaying a temporary name (New Text Document) in the My Work folder.

Type a name for the new file (i.e. My First File) and press Enter.

A blank new text file with the name My First File has been created in the My Work folder.
Creating a blank file from Right Click Menu

A blank new File can also be created by using the Right Click Menu.

1. Open My Work folder in the My Documents (Which you have just created).
2. Right click in the folder.
3. Right click menu appears.
4. Move mouse over NEW.
5. Click the Text Document option.
7. Type a name for the new file (i.e. My First File) and press Enter.
8. A blank new text file with the name My First File has been created in the My Work folder.
2.3.3 Copying a File/Folder

Copying a file/folder is reproducing it at another location (destination) without removing it from its original location. Copy feature is used when a user wants to make an exact copy of a file/folder.

**Copying a file/folder to the Desktop**

1. Open My Work folder in the My Documents (Which you have just created).
2. Select the file (My First File).
3. Click Copy this file in the File and Folder Tasks Pane.
4. Copy Items window appears. Select the destination (Desktop) to paste the file.
5. Click Copy.
6. A copy of the selected file will appear on the Desktop.

You can also copy a file/folder by using right click menu and by Edit menu.
2.3.4 Moving a File/Folder

Moving, cuts the file/folder from its original location and places it at a new location. Cut feature is used when a user wants to shift a file/folder from one location to another.

Moving a file/folder to the Desktop

1. Open My Work folder in the My Documents (Which you have just created).

2. Select the file (My First File).

3. Click Move this file in the File and Folder Tasks Pane.

4. Move Items window appears.

5. Select the destination (Desktop) to paste the file.

6. Click Move.

7. Selected file will be moved on the desktop.

You can also move a file/folder by using Edit menu.
2.3.5 Dragging a File/Folder

A user can also move a file/folder to another location by dragging.

**Dragging a file/folder to the Desktop**

1. Open *My Documents* folder.
2. Select *My Work* folder (Which you have just created).
3. Now drag this folder on the desktop.
4. Selected folder will be moved to the desktop.
5. You can also drag this selected folder back to *My Documents* folder.

*Fig. 2.3.5a My Documents and Desktop*

*Fig. 2.3.5b My Documents and Desktop*
2.3.6 Deleting a File/Folder

A user can delete a file/folder that is no longer required.

Deleting a file/folder

1. Open My Documents folder.
2. Select My Work folder.
3. Click Delete this folder in the File and Folder Tasks Pane or press Delete key on the keyboard.
4. A warning message will appear.
5. Click Yes to confirm the delete action.
6. You will find that the folder (My Work) has been deleted.

You can also delete a file/folder by using right click properties and File menu.

On deleting a file or folder, it is stored in the Recycle bin before it is permanently removed from the Hard disk.
**Summary**

- **Microsoft Windows** is a software which provides a platform to work on a computer.

- The main screen of the Microsoft Windows is known as **Desktop**.

- The **Start button** displays a list of items called **Start menu**.

- **Taskbar** is placed at the bottom of the screen in the Windows. It includes Start button, Quick Launch toolbar, Taskbar buttons and Notification area.

- The area at the bottom right on the screen is known as **Notification area**.

- **Icons** are small images that represent different types of programs and files.

- **My Computer** gives access to all disk drives and other hardware connected to the computer.

- **My Documents** folder is used to save documents such as letters, reports, pictures and media files.

- **Recycle Bin** is the place where Windows stores deleted files.

- A rectangular area on the computer screen in which an application or document is viewed and accessed is known as a **window**.

- The horizontal bar at the top of a window is known as **Title bar**.

- **Maximize button** is used to enlarge a window to full screen and restore it.

- **Minimize button** is used to reduce a window to a button on the taskbar.

- **Close button** is used to close an open window.

- A **Menu bar** of a window contains different menus such as File, Edit, View, Favorites, Tools and Help.

- A **Toolbar** contains different command buttons so a user can access them easily.

- **Status bar** gives information about the window and its contents.

- **Scroll bar** is used to view all the contents of a window vertically and horizontally.

- A **File** is a collection of data that is stored on a computer.

- **Folders** are like envelopes or drawers in which we can place data.
**Exercise**

Q.1 Tick the right choice.

i) ____________ is a software that provides a platform to work on a computer.
   a) Microsoft Windows  
   b) Mouse  
   c) Hardware  
   d) Scanner

ii) The main screen of the Microsoft Windows is known as ____________.
    a) Front top  
    b) Welcome screen  
    c) Desktop  
    d) Home

iii) ____________ gives complete control of the computer under one menu.
     a) Windows menu  
     b) Start help  
     c) Start menu  
     d) Desktop

iv) Taskbar is placed at the ____________ of the screen in Windows.
    a) Left  
    b) Right  
    c) Top  
    d) Bottom

v) ____________ is a place where Windows stores deleted files.
   a) My Documents  
   b) My Computer  
   c) Recycle Bin  
   d) Desktop

vi) Time is displayed in the ____________.
    a) Quick Access Launcher  
    b) Start menu  
    c) Notification area  
    d) Task buttons

vii) ____________ icon gives access to Hard disk and other hardware.
     a) My Document  
     b) Recycle Bin  
     c) Internet Explorer  
     d) My Computer

viii) A ____________ allows a user to work with multiple programs.
      a) Start menu  
      b) Window  
      c) Dialogue box  
      d) Door
Introduction to Windows

Unit - 2

ix) The window/program name is shown on the ________________ bar.
   a) Menu   b) Tool   c) Title   d) Status

x) ________________ bar gives information about the window and its contents.
   a) Status   b) Scroll   c) Task   d) Title

xi) ________________ is a collection of data that is stored on a computer.
   a) Record   b) Data store   c) File   d) Information

xii) Folders are like ________________ in which you can place files/folders.
     a) Envelops   b) Notebooks   c) Files   d) Registers

xiii) ________________ feature is used to make an exact copy of a file/folder.
      a) Copy   b) Cut   c) Drag   d) Delete

taxiv) Cut feature is used to ________________ a file/folder from one location to another.
      a) Copy   b) Shift   c) Delete   d) Arrange

xv) A ________________ is named by a letter followed by a colon (:).
     a) File   b) Folder   c) Drive   d) Window

Q.2 Fill in the Blanks.

i) Desktop contains ________________ of different file/folders and program.

ii) ________________ is used to search information on the World Wide Web.

iii) ________________ bar contains different menus.

iv) A user can ________________ any deleted file from Recycle Bin.
v) _______ bar is used to view all the contents of a window horizontally and vertically.

vi) _______ button is used to enlarge a window to full screen.

vii) Minimize button is used to reduce a window to a button on the ________.

viii) There are _____________ ways to open a program/window.

ix) A file consists of two parts: name and ________.

x) ________ are used to organize data.

Q.3 Differentiate between the following.

i) Desktop and Start menu.

ii) My Documents icon and My Computer icon.

iii) Maximize button and Minimize button.

iv) File and Folder.

v) Copy a file/folder and Cut a file/folder.

Q.4 Define the following.

i) Desktop

ii) Folder

iii) Start menu

iv) A window

v) Task bar

Q.5 Give brief answers to the following questions.

i) Describe the steps of the Start up procedure of the Windows.

ii) What is Start menu?

iii) Describe the function of the Notification area.

iv) How many ways are there to open a window/program in Windows?

v) What is a Drive?

vi) What is a file? Write the parts of a file with an example.

vii) How can a user create a folder using right click menu?

viii) What is the importance of folders? Explain briefly with an example.

ix) Write the names of five different parts of a window.

x) What are icons? Write names of the desktop icons.
**Q.6 Match column A with column B and write the numbers of matching pairs in column C.**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>i) Desktop</td>
<td>a) My Computer</td>
<td></td>
</tr>
<tr>
<td>ii) Close button</td>
<td>b) World Wide Web</td>
<td></td>
</tr>
<tr>
<td>iii) Start menu</td>
<td>c) .doc</td>
<td></td>
</tr>
<tr>
<td>iv) Drive</td>
<td>d) Name of the window</td>
<td></td>
</tr>
<tr>
<td>v) File Extension</td>
<td>e) Close a window/program</td>
<td></td>
</tr>
<tr>
<td>vi) Desktop Icon</td>
<td>f) Turn off button</td>
<td></td>
</tr>
<tr>
<td>vii) Notification Area</td>
<td>g) Volume Control</td>
<td></td>
</tr>
<tr>
<td>viii) Title bar</td>
<td>h) Quick Access Launcher</td>
<td></td>
</tr>
<tr>
<td>ix) Internet Explorer</td>
<td>i) C:</td>
<td></td>
</tr>
<tr>
<td>x) Taskbar</td>
<td>j) Main Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>k) Different menus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>l) Shift a file/folder</td>
<td></td>
</tr>
</tbody>
</table>

**Q.7 Label the following diagrams.**

![Diagram of Windows interface](image.png)

- Label the Windows Explorer window.
- Label the Internet Explorer window.
- Label the Start button.
- Label the taskbar.
- Label the notification area.
- Label the desktop icon area.
- Label the My Documents and My Recent Documents folders.
- Label the My Pictures and My Music folders.
- Label the Control Panel and Internet Explorer options in the Start menu.
- Label the Search and Help and Support options in the Start menu.

---

*Note: Diagram labels not provided in the text.*
Lab Activity (Changing Desktop Background)

You can set any picture as a desktop background.

- **Right click** anywhere on the Desktop.

- **Click Properties.**
Introduction to Windows

Display Properties dialogue box appears.

Click Desktop tab.

Select any image from Background list.

Click Apply.

Click OK to close the dialogue box.

The background of your desktop is changed.

Lab Activity (Start Menu)
Write the names of frequently used programs from the Start menu of your computer:

________________________________________

________________________________________

________________________________________

________________________________________

Lab Activity (Notification Area)
Write the names of items displayed on the Notification area of your computer:

________________________________________

________________________________________

________________________________________

Lab Activity (Drives)
How many drives are there in your computer?

________________________________________

Write the names of drives in your computer:

________________________________________

________________________________________

________________________________________
COMMONLY USED SOFTWARE

Software refers to the instructions given to a computer to perform a specific task. The games we play and the programs that we use on the computer are software. There are different types of software. We will discuss four of them in this unit, i.e. MS Paint, MS Word, Typing Tutor and Media Player.

Learning Objectives:
After completing this unit, students will be able to:

- recognize Microsoft Paint window
- get familiar with Menu bar, Toolbox and Color box
- draw with Pencil tool
- use Shape, Spray, Brush and other tools
- copy/paste and modify an image
- save a file
- recognize keys of right and left hands on the keyboard
- use the correct fingers for typing
- build basic typing skills
- improve speed and accuracy
- recognize Word 2007
- identify MS Word User Interface
- create a new document
- edit, select and delete text
- copy, cut and paste text
- know Fonts, Font size
- know Font styles
- align and change case of text
- check spelling and grammar
- save and print a document
- use Media Player
- know how to use different controls
- play a recorded clip
3.1 Working With Microsoft Paint

MS Paint is a graphics software. It is one of the commonly used software for beginners. It is used to draw and edit pictures and graphics on a computer. A user can also use Paint to view and edit scanned photos.

Opening MS Paint

1. Click the Start button.
2. Move the mouse over All Programs.
3. Move the mouse over Accessories.
4. Click the Paint.

Fig. 3.1a Opening Paint
Window of *Paint* appears.

![Paint window diagram](image)

**3.1.1 Menu Bar**

*Menu bar* is located under the title bar. It contains different menus. There are six menus for different purposes such as File, Edit, View, Image, Colors and Help.

**3.1.2 Toolbox**

*Toolbox* contains tools to create, fill and edit objects. *Paint* has plenty of tools for drawing and painting a picture.

The lower part of the toolbox changes to give more options about the selected tool.
3.1.3 Color Palette

The Color Palette consists of two rows of colored boxes. The default foreground and background colors appear in the left of the color box. The top color square represents the foreground color. The bottom color square represents the background color.

The foreground color is used for lines, borders of shapes and text. You can change this color at anytime by clicking a color in the color box.

The background color is used to fill the inside of enclosed shapes and the background of text frames. You can change this color at anytime by right-clicking a color in the color box.
3.1.4 Draw Lines

Paint lets you draw the following types of lines.

**Pencil Tool**

*Pencil Tool* is used to draw freehand. However, we cannot adjust the thickness of the line.

**Brush Tool**

*Brush Tool* is used to make different types of brush strokes.

**Line Tool**

*Line Tool* is used to draw straight lines of different colors and thickness.

**Curve Tool**

*Curve Tool* is used to draw curved lines of different colors and thickness.

### Drawing Straight Lines

1. Select the *Line tool* from the *Toolbox*.
2. Below the *Toolbox*, click a line width.
3. Move the mouse pointer in the drawing area.
4. Press and drag the mouse button to draw a line.

Choose a new color from the color box.

5. Below the *Toolbox*, click a line width.
6. Draw another line.
Similarly, draw lines in different colors and thickness all over the screen.

![Paint window showing various lines drawn in different colors and thicknesses.]

**Fig. 3.1.4a Line Tool**

You can draw a perfectly horizontal, vertical and 45-degree diagonal line by holding the Shift key while dragging.

**Drawing Curved Lines**

⇒ In the **Toolbox**, click **Curve Tool**.

⇒ Below the **Toolbox**, click a line width/thickness.

⇒ Draw a straight line by dragging the pointer.

⇒ To curve the line, press and then drag the pointer until it curves the way you want.

⇒ Repeat this step for the second arc.

You can only create two curves for each line.
Similarly, draw curves in different colors and thickness all over the screen.

**Using Pencil Tool (My Self)**

- In the **Toolbox**, click **Pencil Tool**.
- Try to draw yourself using the **Pencil Tool**.
- Write your name too.
Using Fill with Color Tool

- In the Toolbox, click Pencil Tool.
- Draw a long twisted line in the drawing area.
- Fill in the shapes with different colors using Fill With Color Tool.

![Fig. 3.1.4d Fill With Color Tool](image)

Using Brush Tool

With Pencil Tool, the line thickness always stays sharp and narrow. But with Brush Tool, a user can change the thickness and shape of the line.

- Use different brush shapes and colors to draw lines like these.

![Fig. 3.1.4e Brush Tool](image)
Using Airbrush Tool

In the Toolbox, click **Airbrush Tool**.

Use different spray sizes and spray as follows.

3.1.5 Shape Tools

We can draw shapes like circles, rectangles, triangles, squares, etc. using **Shape Tools**.

- **Rectangle Tool**
  
  Rectangle Tool is used to draw rectangles. To draw a square, hold the Shift key while dragging.

- **Rounded Rectangle Tool**
  
  Rounded Rectangle Tool is used to draw rectangles with rounded corners.

- **Ellipse Tool**
  
  Ellipse Tool lets you make ellipses. To draw a perfect circle, hold the Shift key while dragging.

- **Polygon Tool**
  
  Polygon Tool is used to draw different types of polygon.
**Drawing Rectangles**

1. Select the *Rectangle Tool*.
2. Move the mouse pointer in the drawing area.
3. Press and drag the mouse diagonally to draw a rectangle. Then release the mouse button.
4. Make rectangles all over the screen and color them.

**Paint offers three options to create a shape.**

- Draws the outline of a shape.
- Draws the outline of a shape and fills the inside with color.
- Draws a colored shape with no outline.

---

**Drawing Ovals**

1. Select the *Ellipse Tool*.
2. Move the mouse pointer in the drawing area.
3. Press and drag the mouse diagonally to draw an oval. Then release the mouse button.
Make ovals all over the screen and color them.

Fig. 3.1.5b Ellipse Tool

**Using Text Tool**

- In the Toolbox, click the Text Tool 📒.
- To create a text frame, drag the pointer diagonally to the size you want.
- On the Text toolbar, click the font, size and style you want for the text.
- Click inside the text frame to type text.

Fig. 3.1.5c Text Tool
You can enter text in a text box only once. After you click outside the box, you cannot make it active again.

### 3.1.6 Copy/Paste and Modify an Image

1. **Using Ellipse Tool**, draw a balloon and color it pink.
2. Draw an oval inside the circle and color it light pink.

![Fig. 3.1.6a Drawing a Balloon](image1)

3. Click the **Selection Tool** and drag the mouse to select the balloon.
4. On the **Edit** menu, click **Copy**.
5. On the **Edit** menu, click **Paste**.

![Fig. 3.1.6b Copy and Paste the Balloon](image2)
Change the color of the balloon and drag it to a new location.

On the Image menu, click Stretch/Skew.

Stretch and Skew dialogue box appears.

Under Stretch, type the percent to stretch the image horizontally or vertically.

Click OK.

The balloon is stretched horizontally.
Similarly complete the drawing as given below. Also draw a thread using **Curve Tool**.

![Drawing Threads Using Curve Tool](image)

Using **Text Tool**, type “Happy Birthday”.

![Typing Text](image)

Now, using **Eraser Tool**, delete overlapped threads.
3.1.7 Save File

Now, we are going to save this drawing (file) with the name “Birthday Card”.

- Click the File menu.
- Click the Save option or type Ctrl + S.
- The Save As dialogue box appears.

- Select the folder.
- Type the file name for the drawing.
- Click the Save button.

Fig. 3.1.6g Erasing Unwanted Details

Fig. 3.1.7 Save as dialogue box
3.2 Using a Typing Tutor

Typing is an important skill. It is useful at work and in school. The important things to remember while typing are:

- Use the correct fingers.
- There is no need to rush.
- We should take a rest, shake hands and arms to relax muscles.
- It is important not to look at our hands when we are learning to type.

Typing tutor is a software which helps a user to learn and improve typing skills. A user can install any typing tutor software. After practicing, a user will be able to type fast and accurate.

3.2.1 Home Keys

A S D F and J K L; are called home keys.

Place fingers of left hand on A S D F Place fingers of right hand on J K L;
Use either of the thumbs to press space bar in order to insert space between letters.
### 3.2.2 Correct Fingers for Typing English Text

The color scheme suggests the fingers for the whole keyboard to type English text.

*Fig. 3.2.2 Table of Keys for Each Finger*

#### Table for Typing Keys and Fingers

<table>
<thead>
<tr>
<th></th>
<th>Left Hand</th>
<th>Right Hand</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fore Finger</td>
<td>R T F G V B</td>
<td>Y U H J N M</td>
</tr>
<tr>
<td>Middle Finger</td>
<td>E D C</td>
<td></td>
</tr>
<tr>
<td>Ring Finger</td>
<td>W S X</td>
<td>O L E</td>
</tr>
<tr>
<td>Little Finger</td>
<td>Q A Z</td>
<td>P #: /</td>
</tr>
<tr>
<td>Thumb</td>
<td>Space bar</td>
<td>Space bar</td>
</tr>
</tbody>
</table>
3.2.3 Basic Typing Skills

A user should always start from home keys and always return to them. In this way, fingers never lose their place. In first few lessons, typing tutor will help the user to practice home row.

ASDFGHJKL;

During the lesson typing tutor will show the speed, errors and timing of the typing. After practicing home row, the user can take lessons for the QWERTY row and the row (Z X C V B........) under the home row.

QWERTY Row (Row above the home row)

Color scheme suggests which finger presses which key in QWERTY row.

Row below the home row

Color scheme suggests that which finger presses which key in the row below the home row.
Using a Typing Tutor

Number Row

Color scheme suggests which finger presses which key in the number row.

How to run a Typing Tutor?

→ Click the Start button.
→ Move the mouse over All Programs.
→ Move on the typing tutor.
→ Click the typing tutor (Typing Master).
The typing tutor opens. (The screen of the typing tutor installed on your computer may be different from this one).

Fig. 3.2.3e Welcome Screen of the Typing Tutor

After giving user information, the first lesson appears.

Fig. 3.2.3f Typing Tutor

Click Begin.
An exercise appears, start practicing.

![Typing Tutor](image)

Fig. 3.2.3g Typing Tutor

You can also take the remaining lessons of your typing tutor. It will help you to type quickly and accurately without looking at the keys.

### 3.2.4 Improve Speed and Accuracy Through Typing Tests

After learning and practicing all the keys, a user can take typing tests. These tests help a user to measure his/her typing speed and accuracy.

Speed in typing is defined as the number of words typed in one minute, counting every five strokes (punctuation marks, spaces, letters or numbers) as one word. For example, if a user types 30 words in 3 minutes, his/her typing speed is 10 wpm (words per minute).

**Taking a Typing Test**

- Open typing tutor.
- Choose a test and time duration.
Using a Typing Tutor

Test appears, start typing.

Fig 3.2.4b Typing Test

After completing test, result screen appears.

Fig 3.2.4c Typing Results

In this test the user passed the test with the net speed of 33 words per minute with an accuracy of 89%.
3.3 Working with Word

Word processing means to create, edit and print text documents using software on a computer. The software used to produce text documents on a computer is called a word processor. **Word 2007** is one of the most popular word processing software. It is used to produce reports, messages, notes, letters and other documents.

There are some special words you need to know in order to do word processing.
- Words are called **text**.
- The whole text is called a **document**.

**How to run Word?**

1. **Click the Start button.**
2. **Point to All Programs** to view a list of programs in the computer.
3. **Point to Microsoft Office.**
4. **Click Microsoft Office Word.**

*Fig. 3.3a Opening Word*
The Office Word 2007 window appears, displaying a blank document.

Office Button

Office Button is at the top-left corner of the Word window. It provides fast access to files and frequently used commands such as create a new document, Open an existing document, Save a document, Print a document or Close a document, etc.

Click the Office Button
Quick Access Toolbar

Quick Access Toolbar is located next to the office button. It holds the commands which are used frequently.

Ribbon

The Ribbon is the panel below the title bar. It presents commands organized into a set of tabs called Ribbon Tabs.
The Ribbon is divided into seven tabs and each tab is a collection of several groups that show related items together.

- **Tab** is a collection of several groups of related commands.
- **Groups** show similar commands together.
- **Dialogue Box Launcher** gives access to additional commands.
- **Command Buttons** are used to issue commands or to access menus and dialogue boxes.

### 3.3.1 Creating a New Document

The following steps are required to create a new document.

1. Click the **Office Button** 📊.
2. Click **New** or press **Ctrl+N**.
3. Click **Blank document**.
4. Click **Create**.
5. A new blank document appears on the screen.
3.3.2 Text Editing

Adding, removing and re-arranging text in the document is called text editing.

How to Type and Edit Text?

A flashing vertical line on the screen is called cursor or insertion pointer. The text we type will appear where the insertion pointer flashes on the screen. As we type, the insertion pointer moves horizontally towards the right of the screen. When we reach the end of a line, Word automatically wraps the text to the next line.

1. Open a blank document.
2. Type the following sentence.
   
   I love Pakistan.

3. Place cursor after the word 'love'.
4. Press `Backspace` key to remove the word 'love'.

5. Type the following sentence.
   
   I am proud to be a Pakistani.
3.3.3 Selecting Text

Before using any Word feature, a user must first select the required text. Selected text appears highlighted on the screen.

How to select text?

It is very easy to select text in a document.

- Open a saved document.

Select any amount of text. Just drag the mouse pointer over the text or hold the Shift key and press arrow keys.

Select a word. Move the mouse pointer anywhere over the word you want to select and then double-click the word.

Select a sentence. Hold down Ctrl key and then click anywhere in the sentence.

Select a line
Move the pointer to the left of the line until it changes to a right-pointing arrow and then click.

Select a paragraph.
Move the pointer to the left of the paragraph until it changes to a right-pointing arrow and double-click or triple-click anywhere in the paragraph.

Select an entire document.
Move the pointer to the left of the paragraph until it changes to a right-pointing arrow and triple-click or press Ctrl + A.
### 3.3.4 Deleting Text

Removing text from a document is called **deleting**. A user can remove unwanted text from a document. Following are two different methods to delete text.

- **To delete a single character**
  
  Click to the right of the character and press the **Backspace** key.

- **To delete a word or a block of text**
  
  Select the text and then press the **Delete** key.

### 3.3.5 Copying and Pasting Text

The Copy command creates a duplicate of the selected text, leaving the original text unchanged. The Paste command pastes the copied text at the insertion point. When we copy and paste text, the text appears in both original and new locations.

- Select the text and click the copy button or press **Ctrl + C** on the keyboard.

- Move the cursor where text is to be placed and click the paste button or press **Ctrl + V**.

### 3.3.6 Cutting and Pasting Text

A user can move text from one position to another in a document using the **Cut** and **Paste** commands. The **Cut** command deletes the selected text from its original location. The **Paste** command then places this text at the insertion point.

- Select the text and click the cut button or press **Ctrl + X** on the keyboard.

- Move the cursor where text is to be placed and click the paste button or press **Ctrl + V**.
Cut, Copy and Paste Text (Provinces of Pakistan)

Make a list of four provinces of Pakistan.

Provinces of Pakistan
Sindh
Balochistan
Khyber Pakhtunkhwa
Punjab

Select this list.

Click Copy button or press Ctrl + C and de-select the text.

Press key.

Click Paste button or press Ctrl + V.

Another list of four provinces appears.

Cut and paste them so that most populated province is at the top.

Now Cut and Paste them in reverse order.
3.3.7 Fonts

**Font** is a set of letters, numbers and symbols of a specific design that may be displayed or printed. Fonts make the appearance of a document beautiful and attractive. Fonts have names such as:

<table>
<thead>
<tr>
<th>Font Name</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Different styles of writing are called fonts.</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Different styles of writing are called fonts.</td>
</tr>
<tr>
<td>Magneto</td>
<td>Different styles of writing are called fonts.</td>
</tr>
<tr>
<td>Impact</td>
<td>Different styles of writing are called fonts.</td>
</tr>
</tbody>
</table>

We can choose different fonts to suit the type of a document. For example, if we are writing a notice to place outside a door, we may use bold fonts (e.g. Arial Black, etc). Similarly, if we are writing a business letter, we may use formal fonts (e.g. Times New Roman, etc). Few more examples of fonts are as follows.

**STOP NOW** THESE WORDS ARE HARD AND BOLD

Stop Now These words are scary

Stop Now These words are fancy

Stop Now These words are romantic

3.3.8 Font Size

**Font size** means the height of letters or other characters. We can increase or decrease the size of text in a document. Word measures the size of text in points. There are approximately 72 points per inch.

**Changing Fonts and Size**

Type your name and school’s name as follows.
Nadeem Nasir,
Govt. High School, Chak No. 149, Arifwala

Fig 3.3.8a A Word Document

→ Select it.
→ On the Home Tab, in the Font group, click here to see a list of fonts.
→ A drop-down list of fonts appears.
→ Choose a new font.
→ Font of your name and school's name is changed.

Nadeem Nasir,
Govt. High School, Chak No. 149, Arifwala

Fig 3.3.8b Changing Font

→ Select the text.
→ On the Home Tab, in the Font group, click here to see a list of font sizes.
3.3.9 Font Styles

To emphasize information in the document, a user can make the text bold, italic and underlined. A user can easily activate any of these formatting commands by clicking any of the following buttons.

- **Bold catches your attention.**
- **Italic is stylish.**
- **Underline highlights something important.**
Changing Font Style

Type the following poem.

Early to bed and early to rise
Makes a man
Healthy, wealthy and wise.

Select the first line of the poem.

On the Home Tab, in the Font group, click the bold button \( \textbf{B} \) to make it bold and underline button \( \underline{U} \) to underline it.

\textbf{Early to bed and early to rise}

Select the second line of the poem.

Click the Italic button \( \textit{I} \) or press.

Similarly, on the third line of the poem apply the underline effect \( \underline{U} \).

\textbf{Early to bed and early to rise}

Makes a man
Healthy, wealthy and wise
3.3.10 Text Alignment

Alignment is the way in which text is placed between the margins of a page. We can enhance the appearance of the document by changing the position and layout of the text on the page. Text alignment can be changed by using these buttons.

**Left Align**
Aligns text at the left margin. This is the default setting. Left alignment of text is found in most documents.

**Center**
The text is centralized on a line. It can be used in a card, on an envelope and in a listing.

**Right Align**
Aligns text at the right margin. This can be used for addresses.

**Full Justification**
The text is justified on both sides. It can be seen in books, newspapers, magazines and reports.

Alignment of Text

Type a short poem.

```
Early to bed
And early to rise
Makes a man
Healthy, wealthy and wise
```

Align icons

Hold **Ctrl** and press A to select all text.

On the **Home Tab**, in the **Paragraph group**, click each **Align icon** one by one to see new layouts.
3.3.11 Changing Case of Text

We can change the selected text to UPPERCASE, lowercase or other cases. There are five case options available in Word 2007.

- **Sentence Case**  First character in the sentence is in uppercase and the rest are in lowercase.
- **lower case** All characters are in lowercase (small letters).
- **UPPERCASE** All characters are in uppercase (capital letters).
- **Title case** First character of each word is capital and the rest are small.
- **tOGGLE cASE** First character of each word is small and the rest are capital.

**Changing Text to Upper Case**

1. Type your name.
2. Select your name.
3. On the **Home Tab**, in the **Font group**, click **Change case icon**.
5. Now select the **UPPERCASE** option.
6. Your name changes to the new case style.

MUHAMMAD NADEEM

7. Now, one by one, use other four options.
3.3.12 Check Spelling and Grammar

Word underlines possible spelling and grammatical errors in the document. Words that are not in Word's dictionary are underlined with a red wavy line. Grammatical errors are underlined with a green wavy line.

**Spelling and Grammar Check**

1. Type the following paragraph.

```
Drawing room are the largest room in my house. It is well decorated by my mother. It has two sofa sets and a carpet on the floor.
```

2. On the Review Tab, in the Proofing group, click Spelling & Grammar icon.

3. Spelling & Grammar dialogue box appears if Word finds an error in the document.

4. In the beginning, Word displays the spelling errors.

5. Click Change to correct error in the document.

Fig. 3.3.12b Spelling and Grammar Dialogue Box

MS Word underlines mis-spelled words in red and grammar errors in green. The underlines will not appear when you print your document.
Similarly, correct all spelling errors.

Next, a window appears showing the grammar errors.

Choose the right suggestion.

Click **Change** to correct error in the document.

Similarly, correct all spelling and grammatical errors until this dialogue box appears.

Click **OK** to close the dialogue box.

### 3.3.13 Saving a Document

After completing the work, the user can save the document for future use. To save the document the user has to give it a name.

**Following steps are used to save a document.**

- Open a blank document.
- Type your name, class and school's name.
- Click **Save button** or press **Ctrl+S** to save the document.
The Save As dialogue box appears.

Save in
My Documents.

Type a name of your work here.

Click Save.
This will save your document with the name My First File in the folder of My Documents.

To exit the program click here.

Fig. 3.3.13a Save As Dialogue Box

Fig. 3.3.13b Saved Document
3.3.14 Printing a Full Document

A user can easily produce a hard copy (paper copy) of the document. A user can print a single page, specific pages or the entire document.

→ Open the document “My First File.docx”

![Word Document Image]

→ Click the Office Button.

→ Point to the arrow next to Print and then click Print or just press Ctrl + P.

Before printing the document, make sure that the printer is ON and it contains paper.

![Printing the Document Image]
3.4 Using Media Player

Media Player is a software which plays video and audio files. In Microsoft Windows this software comes with the name Windows Media Player. In this player, we can watch movies and listen to songs from CD/DVD or from already stored video and audio files in the computer.

**Opening Windows Media Player**

1. Click Start.
2. Point to All Programs ➔ Accessories ➔ Entertainment.
3. Click Windows Media Player.

![Image of Windows Media Player](image.png)
3.4.1 Using Playback Controls

The buttons which are used to control an audio/video file are known as playback controls. There are several playback controls in media player. Some of the most important playback controls are discussed below.

**Play/Pause**

This button is used to play and pause any audio/video file. When a file is playing, it turns into pause button and when a user pause a file it turns into play button.

**Stop**

Stop button is used to stop any file playing in media player. A user can play it again by clicking on the play button. The file will start playing from the beginning.
Fast Forward/Rewind
These buttons are used to control the speed of the file. A user can increase the file speed by clicking the fast forward button and decrease the speed of the playing file by clicking the rewind button.

Adjust Volume and Mute
The volume slider is used to control the volume level of the file. A user can move the slider right to increase the volume and left to decrease it. You can also turn off the volume of the file by clicking the “Mute” button.

3.4.2 Playing a Recorded Clip From CD/DVD

1. Insert a video CD in the CD drive.

2. Double click CD drive icon in the My Computer.
A window with contents of the CD appears.

Double click the MPEGAV folder.

Double click the AVSEQ01 video file.

The video file starts playing in the Media Player.
Summary

- Microsoft Paint is a graphics software. It is used to draw and edit images.
- Brush tool is used to draw lines with different thickness.
- Rectangle tool is used to make rectangles.
- Ellipse tool is used to make ellipses.
- Line tool is used to draw straight lines of different colors and thickness.
- Curve tool is used to draw curved lines of different colors and thickness.
- Fill with color tool fills the screen or an enclosed shape with a color.
- Airbrush tool creates a spray pattern.
- The color palette consists of two rows of colored boxes. To set the foreground color, click on any colored box.
- The foreground color is the color that the pencil draws with.
- The background color is the color of the background.
- Pencil tool is used to draw freehand. However, you cannot adjust the thickness of the line with this tool.
- Text tool creates a text frame in which a user can choose the font, size, and style to type.
- Typing Tutor is a software which helps a user to learn and improve typing skills.
- A S D F and J K L; are called home keys.
- Speed in typing is defined as the number of words typed in one minute counting every 5 strokes (punctuation marks, spaces or letters) as one word.
- The software used to produce documents is called Word Processor.
- Microsoft Office Button provides fast access to files and frequently used commands.
- Quick Access Toolbar holds the commands which are frequently used.
- Ribbon presents commands organized into a set of tabs.
- Adding, removing and re-arranging text in the document is called text editing.
- Selected text appears highlighted on the screen.
- The Copy command creates a duplicate of the selected text leaving the original text unchanged.
Commonly Used Software

1. The **Cut** command moves the selected text from its original location.
2. The **Paste** command pastes the copied and cut text at the insertion point.
3. **Font** is a set of letters, numbers and symbols of a specific design that may be displayed or printed.
4. **Font size** means the height of the letters or other characters.
5. To emphasize information in a document, a user can make the text **bold**, **italicized** or **underlined**.
6. User can change the selected text to **UPPERCASE**, **lowercase** or other common capitalizations.
7. Word underlines possible spelling and grammatical errors in the document.
8. **Media Player** is a software which plays video and audio files.
9. **Play/Pause** is used to play and pause audio/video file.
10. **Stop button** is used to stop any file playing in the media player.
11. **Fast forward and rewind buttons** are used to control the speed of the file.
12. **The VolumeSlider** is used to control the volume level of the file.

**Exercise**

Q. 1 Tick the right choice.

i) Paint is a _____________ software.
   a) Graphics  
   b) Typing  
   c) Word Processing  
   d) Mathematical

ii) A user can draw perfect circle by ellipse tool using _____________ key while dragging the Mouse.
   a) Ctrl  
   b) Shift  
   c) Caps Lock  
   d) Alt

iii) _____________ tool is used to write text in the drawing.
   a) Shift  
   b) Text  
   c) Pencil  
   d) Curve

iv) Airbrush tool creates a _____________ pattern.
   a) Spray  
   b) Line  
   c) Curve  
   d) Color
v) ________________ tool is used to fill the screen or a closed shape.
   a) Eraser  b) Text  c) Fill with color

vi) ________________ tool is used to zoom in the drawing.
   a) Line  b) Magnifier  c) Brush  d) Curve

vii) ________________ keys are called home keys.
   a) A S D F and J K L ;  b) Q W E R T Y  c) Z X C V B  d) F G H J K L

viii) ________________ is defined as the number of words typed in one minute.
   a) Typing tutor  b) Typing skill  c) Typing speed

ix) ________________ are the keys settings for the left hand.
   a) A S D F  b) Q W E R  c) Z X C V  d) D F G H

x) ________________ is the most popular word processing software.
   a) Word  b) Excel  c) Paint  d) Notepad

xi) ________________ button is located on the top left corner of Word 2007.
   a) Microsoft Office button  b) Ribbons  c) Microsoft Home  d) Save

xii) The ________________ is the panel at the top of the document.
   a) Ribbons  b) Office button  c) Tab  d) Quick Access Toolbar

xiii) Delete key deletes the characters from the ________________ side of the cursor.
   a) Left  b) Right  c) Up  d) Down
Commonly Used Software

Unit - 3

xiv) _____________ is a software which is used to play audio and video files.
   a) Media player  
   c) Word
   b) Typing Tutor  
   d) Paint

xv) Mute button is used to _____________ the volume.
   a) Turn on  
   c) Turn off
   b) Increase  
   d) Decrease

Q. 2 Fill in the blanks.

i) Pencil tool is used to draw _____________

ii) Airbrush tool creates a _____________ pattern.

iii) The home keys consists of _____________ keys.

iv) _____________ is used to press Space bar.

v) Word is a _____________ processing software.

vi) _____________ show similar commands together.

vii) Adding, removing and re-arranging text in Word document is known as _____________

viii) _____________ is the shortcut key to bold the text.

ix) _____________ errors are underlined by green wavy line.

x) _____________ button is used to stop any file in the Media player.

Q. 3 Define the followings.

i) Text Editing
ii) Ribbon
iii) Toolbox
iv) Playback Controls
v) Text Alignment
Q.4 Differentiate between the following.

i) Brush tool and Pencil tool
ii) Delete key and Backspace key
iii) Foreground and Background color boxes
iv) Pause button and Stop button
v) Cut text and Copy text

Q.5 Give brief answers to the following questions.

i) What are the uses of Paint?
ii) How can a user draw a freehand drawing in Paint?
iii) Explain the importance of home keys in typing.
iv) Write the steps to create new Word document.
v) Write the names of different case options in Word 2007.
vi) Define the font and write the names of three famous fonts.
vii) Explain text alignment and its different types.
viii) Write down the steps to access Media player in the Windows?
ix) Write name of the tool used to draw curves.
x) How can we draw a circle in Paint?

Q.6 Match column A with column B and write the numbers of matching pairs in column C.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>i) ASDFJKL</td>
<td>a) Fill the closed shape</td>
<td></td>
</tr>
<tr>
<td>ii) Brush tool</td>
<td>b) Spray</td>
<td></td>
</tr>
<tr>
<td>iii) Text tool</td>
<td>c) Brush strokes</td>
<td></td>
</tr>
<tr>
<td>iv) Line tool</td>
<td>d) Home keys</td>
<td></td>
</tr>
<tr>
<td>v) JKL</td>
<td>e) Right hand keys</td>
<td></td>
</tr>
<tr>
<td>vi) Fill with color</td>
<td>f) Text frame</td>
<td></td>
</tr>
<tr>
<td>vii) Eraser tool</td>
<td>g) Straight line</td>
<td></td>
</tr>
<tr>
<td>viii) Airbrush tool</td>
<td>h) Erase a picture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>i) Left hand keys</td>
<td></td>
</tr>
<tr>
<td></td>
<td>j) Typing Speed</td>
<td></td>
</tr>
</tbody>
</table>
Q.7 Match column A with column B and write the numbers of matching pairs in column C.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>I) Word processing</td>
<td>a) Ctrl + X</td>
<td></td>
</tr>
<tr>
<td>ii) Media player</td>
<td>c) Times New Roman</td>
<td></td>
</tr>
<tr>
<td>iii) Increase playback speed</td>
<td>d) Turn off volume</td>
<td></td>
</tr>
<tr>
<td>iv) New document</td>
<td>e) Ctrl + P</td>
<td></td>
</tr>
<tr>
<td>v) Font</td>
<td>f) Fast forward</td>
<td></td>
</tr>
<tr>
<td>vi) Cut Text</td>
<td>g) Windows Media Player</td>
<td></td>
</tr>
<tr>
<td>vii) Print</td>
<td>h) Ctrl + N</td>
<td></td>
</tr>
<tr>
<td>ix) Font Style</td>
<td>I) Italic</td>
<td></td>
</tr>
<tr>
<td>x) Mute</td>
<td>j) MS Word</td>
<td></td>
</tr>
<tr>
<td></td>
<td>k) Ctrl + C</td>
<td></td>
</tr>
<tr>
<td></td>
<td>l) Ctrl + N</td>
<td></td>
</tr>
</tbody>
</table>

Q.8 Label the following diagram.

```plaintext
For Help, click Help Topics on the Help Menu.
```
Commonly Used Software

Unit - 3

Lab Activity (Using Shape Tools)

➡️ Select the rectangle tool 🖼.

➡️ Draw two rectangles like this.

➡️ Using bucket tool color them gray.

➡️ Draw a rounded rectangle inside the big triangle and color it white.

Lab Activity (To Draw a Tree)

➡️ Select brown color from the color box.

➡️ Click brush tool 🖼️ and use thick brush to draw stem and branches.

➡️ Now select green color from the color box.

➡️ Draw leaves using brush tool.

Activity (Using Brush Tool)

➡️ Click brush tool 🖼️ and draw a heart with blue color.

➡️ Select another color and write some message.

I ❤️ Pakistan
Commonly Used Software

**Lab Activity (Spray Tool)**
- **Spray tool** can also be used for the leaves of a tree.
- Click and move the spray can quickly to make the leaves.
- You can also change the size of the spray.

**Lab Activity (Face)**
- Use brush tool for the face and spray tool for hair.
- Change the hair style.

**Lab Activity (Brinjal)**
- Using **ellipse tool** draw an oval.
- Use **magnifier** tool to make it big.
- Using **brush tool** draw upper portion of a brinjal.
- Color the brinjal with **airbrush** tool.
Lab Activity (Changing Font Size and Color)

⇒ Type your first name.
  Arif

⇒ Double click to select it.

⇒ Click Copy or Press Ctrl + C.

⇒ De-select the word.

⇒ Click paste or Press Ctrl + V.
  Arif Arif

⇒ Now similarly paste your name six times.

⇒ Put two spaces between each one.
  Arif Arif Arif Arif Arif Arif

⇒ Now make each name bigger than the last one.
  Arif Arif Arif Arif Arif Arif

⇒ Color each name a different color.

⇒ You can do this by selecting a word and choosing color from here on the Home Tab and in the Font group.
Lab Activity (Font Chart)

- Type capital alphabet.

<table>
<thead>
<tr>
<th>ABCDEFGHIJKLMNOPQRSTUVWXYZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
</tbody>
</table>

- Select it.

- Copy and paste it nine times.

<table>
<thead>
<tr>
<th>ABCDEFGHIJKLMNOPQRSTUVWXYZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
</tr>
</tbody>
</table>

- Now select one line at a time and give each line a different font and color.

- Write the font name after each line.

<table>
<thead>
<tr>
<th>ABCDEFGHIJKLMNOPQRSTUVWXYZ</th>
<th>(Arial)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Chiller)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Comic Sans MS)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Calligraphia)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(CASTELLAR)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Cooper Black)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(STENCIL)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Wingdings)</td>
</tr>
<tr>
<td>ABCDEFGHIJKLMNOPQRSTUVWXYZ</td>
<td>(Times New Roman)</td>
</tr>
</tbody>
</table>
**Lab Activity (Editing)**

- Open a new document and save it as “Application”.
- Type the following text.
- Use the Arial font.
- Perform the editing and formatting as shown.

```
To
The Principal,
Govt. Islamia High School,
Multan

Sir,
Respectfully, I beg to state that I am sick. Therefore, I cannot come to school. Kindly grant me a leave for two days. I shall be very thankful to you.

Yours obediently,
Shahzad Khan
Class 6th, A.
Roll No. 15
```

- a) Replace with: Headmaster
- b) Place a Comma here.
- c) Justify this paragraph
- d) bold
- e) Italicize
- f) Right Align

**Lab Activity (Top Ten TV Programs)**

- Make a list of ten TV programs.

POGO
Thunder Cats
National Geography

.......

.......

- Cut and paste them so that your favorite is at the top.
The Internet is the collection of a large number of computers connected together all over the world. By using Internet we can look up information on any subject or send and receive messages through e-mail.

In this unit, we will also discuss the World Wide Web - the fastest growing area of the Internet made up of millions of web sites.

**Learning Outcomes:**

After completing this unit, students will be able to:

- define Internet
- know what Internet offers
- know the means of connecting to the Internet
  - Telephone (dial up) modem
  - DSL
  - Cable modem connection
- explain the step involved in accessing Internet
- know the World Wide Web
- know web page
- know web site
- know the URL
- know a web browser
- use of Internet Explorer
- know the search engines
  - Google
  - Yahoo
  - MSN
4.1 Introduction to the Internet

Today billions of users around the world access the services of the Internet. We can exchange messages, share information, buy and sell things and communicate with each other while using the Internet.

4.1.1 Internet

The Internet is the largest network of computers around the world. It connects many smaller networks together and allows all the computers to exchange information with each other.

A network is a system of interconnected computers that communicate with one another and share application, data and hardware components.
4.1.2 Internet Services

The Internet has become so important that its use is considered as the essential part of computer use. The most commonly used internet services are shown below.

![Diagram of Internet Services](image)

**The World Wide Web**

World Wide Web is a collection of web pages on the Internet which provide a variety of information that can be accessed by people all over the world.

**E-mail (Electronic Mail)**

A user can send and receive electronic messages and files to anyone in the world using E-mail service.

**Shopping**

A user can buy and sell things on Internet while sitting at home.
Introduction to the Internet

Chatting
A user can chat with anyone using this service. Chat room is a location on Internet that allows users to chat and share ideas with one another.

Instant Messaging (IM)
A user can chat with his/her online friends using the service of instant messaging. Some IM services also provide audio and video conversation.

News
A user can read a newspaper online. A user can access web sites of different news channels to keep themself update.

Entertainment
A user can access unlimited range of pictures, music and videos using Internet. A user can also play online computer games.

Education
A user can access books and articles of any subject on the Internet. A user can take online lectures and training on different subjects.

4.1.3 Means of Connecting to the Internet

When a user wants to access Internet, first of all he/she has to establish a connection of the computer to the Internet. This connection is provided by a company which is known as Internet Service Provider (ISP). These ISPs offer different types of connections.

- Telephone (dial-up) modem
- Cable modem
- DSL (Digital Subscriber Line)
**Introduction to the Internet**

### Telephone (Dial-up) Modems

*Dial-up connection* is a technology that helps a user to connect to the Internet using standard telephone lines. A user can access the Internet by plugging in the telephone line in the modem. It is a slow-speed and inexpensive technology. In this type of connection, telephone line remains busy, one cannot make calls.

![Diagram of Dial-up Connection](image)

**Digital Subscriber Line (DSL) Modem Connection**

*DSL* is a high-speed Internet technology that runs over standard phone lines. It is one of the fastest and affordable Internet connections. A DSL modem is connected to the computer with a network card. In DSL connection, telephone line remains free to make calls.

![Diagram of DSL Modem Connection](image)
**Introduction to the Internet**

**Unit 4**

**Cable Modem Connection**

Cable modem service is a technology that helps users to connect to the Internet using their cable TV wire. It provides a high speed connection as compared to the dial-up modems. It provides an “always ON” connection. It means whenever a computer is powered on the connection is “ON”. Cable modem can be connected to the computer with the network card.

![Cable Modem Connection Diagram](image)

**Fig. 4.1.3c Cable Modem Connection**

**4.1.4 Connecting to the Internet**

Following are the requirements to access the Internet.

1. Computer
2. Modem
3. Telephone/Cable TV Line
4. ISP (Internet Service Provider)
5. Web Browser

1. **Computer**

   Computer is the most essential part to access the Internet. We cannot access Internet without a computer.
2. Modem

A **Modem** is a device which is used to connect and communicate with other computers. There are two types of modems:

- **Internal Modem**
  - Placed inside system unit, used for dial-up connection

- **External Modem**
  - Placed outside system unit, used for DSL and Cable modem connection

3. Telephone/Cable TV Line

A telephone line is required for Dial-up and DSL connections.

A Cable TV line is required for Cable modem connection.

4. Internet Service Provider (ISP)

A company which provides an Internet connection is known as Internet Service Provider (ISP). Some of the leading ISPs in Pakistan are:

- Pakistan Telecommunication Limited
- Watereen Telecom
- World Call Telecom
- wi-tribe

5. Web Browser

A **web browser** is a software which is used to access and view different websites. Some popular web browsers are:

- Microsoft Internet Explorer
- Mozilla Firefox
- Google Chrome
- Opera
4.2 World Wide Web (The Web)

The World Wide Web is the most popular service provided by the Internet. It is also known as "The Web". The Web is the collection of web pages on the Internet. It contains a variety of information that can be accessed by the people all over the world.

4.2.1 Web Page

A Web page is a document on the World Wide Web. It can contain text, graphics, audio, videos and links to other pages.

Fig. 4.2.1 Web Page
4.2.2 Website

A Website is a collection of related Web pages. Each website contains a number of documents and files.

The very first page of the Website is known as Home Page. It serves as an introduction of the entire website. A user can access any website in the world by writing its address in the address bar of the Web Browser. He/she can move from one page to another page of the website.

This is the home page of the Pakistan Air Force website.

4.2.3 URL (Uniform Resource Locator)

URL (Uniform Resource Locator) is an address of a web page on the Internet. Every web page has a unique address. A web page can only be accessed if we know the URL of that page. For example, Google is one of the most popular websites and its URL is http://www.google.com.
4.2.4 Web Browser

Web browser is a software that is used to access the World Wide Web. We can access and view different web pages or websites using a web browser. It is a user-friendly software. We can type URL of any website on its address bar, and the browser will show that particular website.

Some of the most popular browsers are Microsoft Internet Explorer, Mozilla Firefox, Google Chrome, Opera and Safari.
4.2.5 Internet Explorer

In Windows, the software which serves as a web browser is known as Internet Explorer. It has different menus, buttons and icons to help a user to access different websites and webpages.

**Address Bar**
You can type the URL of the desired website here.

**Refresh Button**
A web page is re-loaded by clicking this button.

**Stop**
You can stop the browsing of a web page by clicking this button.

**Back and Forward Buttons**
These buttons are used to go back and forth among pages of a website or multiple websites. These buttons enable only when user visits more than one page.

**Menus**
You can use different menu options by using these menus.

**New Tab Button**
A new tab window opens by clicking this button.
4.2.6 Accessing Different Web Pages Using Internet Explorer

1. Open Internet Explorer
2. Type the URL `www.google.com` in the address bar.
3. Press Enter key.
4. The web page of Google appears.

Now, one by one, type the following URLs in address bar of Internet Explorer:

1) www.yahoo.com
2) www.bing.com
3) www.typingtutor.com
4) www.funbrain.com
4.2.7 Search Engines

Search Engine is a program that is used to find web pages and websites on the Internet. When we type a word or a phrase, the search engine will show a list of websites with related information.

Some of the most popular search engines are listed below.

- MSN (www.msn.com)
- Yahoo (www.yahoo.com)
- Google (www.google.com)
- AltaVista (www.altavista.com)
- Ask (www.ask.com)

Fig. 4.2.7a Different Search Engines
Using MSN Search Engine

1. Open Internet Explorer.
2. The home page of the browser opens. By default MSN is set as home page of Internet Explorer.
3. If MSN is not your home page, type the URL www.msn.com in the address bar and press Enter key.
4. The web page of MSN appears.
5. Type “Pakistan Cricket Team” in the search bar and Click search button.
6. List of related web pages or web sites appears.
Using Yahoo Search Engine

1. Open Internet Explorer.
2. The home page of the browser opens. By default MSN is set as home page of Internet Explorer.
3. Type the URL www.yahoo.com in the address bar and press Enter key.
4. The web page of Yahoo appears.
5. Type “Pakistan Cricket Team” in the search bar and Click search button.
6. List of related web pages or web sites appears.
Using Google Search Engine

1. Open Internet Explorer.
2. The home page of the browser opens. By default, MSN is set as the home page of Internet Explorer.
3. Type the URL www.google.com in the address bar and press Enter key.
4. The web page of Google appears.
5. Type "Pakistan Cricket Team" in the search bar and click the search button.
6. List of related web pages or websites appears.
Summary

- **The Internet** is the largest network of computers around the world.
- A company which provides an Internet connection is called **ISP**.
- **Dial-up connection** is a technology that helps a user to connect to the Internet using standard telephone lines.
- **DSL** is a high speed, digital, always-ON Internet technology that runs over standard phone lines.
- **Cable modem service** is a technology that helps users to connect to the Internet using their cable TV wire.
- **A modem** is a device which is used to connect and communicate with other computers.
- **A web browser** is a software that is used to access and view different websites.
- **The World Wide Web** is the collection of web pages and websites on the Internet.
- **A Web page** is a document on the World Wide Web. It can contain text, graphics, audio, videos and links to other pages.
- **A Website** is a collection of related web pages. Each website contains a number of documents and files.
- **URL (Uniform Resource Locator)** is the address of a web page on the Internet.
- In Microsoft Windows, the software which serves as a web browser is known as **Microsoft Internet Explorer**.
- **A Search Engine** is a program that is used to find web pages and websites.

Exercise

Q.1 **Tick the right choice.**

i) The largest network of computers around the world is known as ____________

   a) Internet  
   b) Network  
   c) Intranet  
   d) Group

ii) IM stands for ________________

   a) Instant Making  
   b) Internet Messaging  
   c) Instant Messaging  
   d) Instant Messages
iii) ISP stands for _____________________________.
   a) Internal Server Provider   b) Internet Service Provider
e) Internet Supply Package    d) Internet System Provider

iv) DSL stands for ________________
   a) Digital Subscriber Line   b) Digital Super Line
c) Data Subscriber Line      d) Digital Subscriber Lane

v) There are _________________ types of modems.
   a) Two                    b) Three
   c) Four                  d) Five

vi) Which of the following is an Internet Service Provider?
   a) PLTC                   b) PLCT
   c) PTCL                  d) PTCL

vii) The software that is used to access and view web pages is called ____________
     a) Web Server           b) Web Browser
c) Web Explorer           d) Web linker

viii) WWW stands for ________________
      a) World Wide West     b) World Was Web
c) World Wide Work        d) Wold Wide Web

ix) Collection of different web pages and sites on the internet is also called ____________
     a) Web                  b) The Web
c) Web Link               d) The Wax

x) A single document on the world wide web is known as ________________
    a) Web page             b) Website
c) Web link               d) Web cam

xi) A _____________________ is a collection of related web pages.
    a) Web site             b) Web Page
c) Web browser            d) Web cam
The Internet and World Wide Web

xiii) The web address of the web page is known as ________________.

a) URL  
b) URS  
c) WRL  
d) QRL

xiv) ________________ is the home page of the Internet Explorer.

a) ASN  
b) MSN  
c) MNS  
d) NSM

tax) ________________ is a program that is used to find web pages and websites.

a) Find and Search  
b) Explore Engine  
c) Search Browser  
d) Search Engine

Q.2 Fill in the blanks.

i) A ________________ is a system of interconnected computers.

ii) A user can send to and receive a message from any one in the world through ________________ service.

iii) We can buy or sell things sitting at our home using Internet is known as ________________ shopping.

iv) Internal Modem is placed inside the ________________.

v) The company that provides Internet connection is known as ________________.

vi) A DSL modem connection uses ________________ lines.

vii) In Windows, the software that serves as a web browser is called ________________.

viii) We can access any website by writing its URL in the ________________ of the web browser.

ix) The very first page of the website is called ________________ page.

x) ________________ is the most popular search engine in the world.

Q.3 Define the following.

i) Internet  
ii) World Wide Web  
iii) DSL

iv) Web Browser  
v) Web site  
vi) URL
Q.4 Give brief answers to the following questions.
   i) List five uses of the Internet.
   ii) Write steps to connecting to the internet.
   iii) Define Modem and its types.
   iv) Write names of some popular web browsers.
   v) What are the major differences between Dial-up and DSL connections?
   vi) How can we access websites in Microsoft Windows?
   vii) Describe Cable Modem Internet connection.
   viii) Describe the function of Refresh, Stop, Next, Back and Stop buttons in Internet Explorer.
   ix) How can we search a web page using Search Engine?
   x) Write names and URLs of some popular search engines.

Q.5 Differentiate between the following.
   i) Internet and World Wide Web
   ii) Chatting and Instant Messaging
   iii) Web page and Website
   iv) Telephone Modems and Cable Modems
   v) Web Browser and Search Engine

Q.6 Label the following diagram.
Q.7 Label the following diagram.


Explain the Internet connection with the help of the above diagram.

Q.8 Match column A with column B and write the numbers of matching pairs in column C.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>i) URL</td>
<td>a) Related web pages</td>
<td></td>
</tr>
<tr>
<td>ii) Web Browser</td>
<td>b) Largest network</td>
<td></td>
</tr>
<tr>
<td>iii) Website</td>
<td>c) Digital Subscriber Line</td>
<td></td>
</tr>
<tr>
<td>iv) Search Engine</td>
<td>d) Cable TV wire</td>
<td></td>
</tr>
<tr>
<td>v) Internet Service</td>
<td>e) E-mail</td>
<td></td>
</tr>
<tr>
<td>vi) DSL</td>
<td>f) Yahoo</td>
<td></td>
</tr>
<tr>
<td>vii) Dial-up Connection</td>
<td>g) Internal Modem</td>
<td></td>
</tr>
<tr>
<td>viii) www</td>
<td>h) PTCL</td>
<td></td>
</tr>
<tr>
<td>ix) Internet</td>
<td>i) Mozilla Firefox</td>
<td></td>
</tr>
<tr>
<td>x) ISP</td>
<td>j) World Wide Web</td>
<td></td>
</tr>
<tr>
<td></td>
<td>k) Universal Resource Locator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>l) Data Subscriber Line</td>
<td></td>
</tr>
</tbody>
</table>
Answers

Unit 1 Introduction to Computers

Q.1 Tick the right choice.

i. (a) Data                   ii. (b) Information
iv. (c) Microsoft Windows     v. (c) QWERTY
vii. (a) System unit         viii. (c) Digital Camera
x. (d) Printer               xi. (b) Central Processing Unit
xiii. (b) Output             xiv. (d) Printer

Q.2 Fill in the blanks.

i. Instructions
iv. Single
vi. Processing
vii. Floppy

Q.6 Match Columns.

If, ii a, iii b, iv j, v k, vi h, vii c, viii l, ix e, x d

Unit 2 Introduction to Windows

Q.1 Tick the right choice.

i. (a) Microsoft Windows
iv. (d) Bottom
vi. (d) My Computer
x. (a) Status
xiii. (a) Copy

Q.2 Fill in the blanks.

i. Icons
iv. Restore
vii. Taskbar
x. Folders

Q.6 Match Columns.

i, j, ii e, iii f, iv l, v c, vi a, vii g, viii d, ix b, x h
Unit 3 Commonly Used Software

Q.1 Tick the right choice.
   i. (a) Graphics
   iv. (a) Spray
   vii. (a) ASDF and JKL;
   x. (a) MS Word
   xiii. (b) Right

Q.2 Fill in the blanks.
   i. Freehand
   iv. Thumb
   vii. Text editing
   x. Stop

Q.6 Match the columns.
   i d, ii c, iii f, iv g, v e, vi a, vii h, vii b

Q.7 Match the columns.
   i j, ii g, iii f, iv h, vi c, vii a, viii e, ix i, x d

Unit 4 The Internet and World Wide Web

Q.1 Pick the right choice.
   i. (a) Internet
   iv. (a) Digital Subscriber Line
   vii. (b) Web Browser
   x. (a) Web Page
   xiii. (a) URL

Q.2 Fill in the blanks.
   i. Network
   iv. System Unit
   vii. Internet Explorer
   x. Google

Q.8 Match the columns.
   i k, ii l, iii a, iv f, v e, vi c, vii g, viii j, ix b, x h
Glossary

Advantages of using computers are speed, accuracy, reliability, storage and versatility.

Airbrush tool creates a spray pattern.

Background color is the color of the background.

Brush tool is used to make different types of brush strokes.

Cable modem service is a technology that helps users to connect to the internet using Cable TV wire.

CD/DVD is a portable, inexpensive and comparatively less reliable storage device.

Click: Quickly pressing and releasing the mouse button once is called click.

Close button is used to close an open window.

Color palette consists of two rows of colored boxes.

Communication devices are used to communicate and connect a computer with other computers.

Computer is an electronic machine which processes raw data (input) into meaningful information (output), and also stores output for later use.

Copy command creates a duplicate of the selected text, leaving the original text unchanged.

Curve tool is used to draw curved lines of different colors and thickness.

Cut command deletes the selected text from its original location.

Data: Collection of facts and figures (unprocessed items) are known as data.

Desktop: The main screen of Microsoft Windows is known as desktop.

Dial up connection is a technology that helps a user to connect to the internet using standard telephone lines.

Digital camera allows a user to take pictures and store them into the computer instead of a traditional film.

Double click: Quickly pressing and releasing the left mouse button twice is called double click.

Dragging: To press and continue to hold the left mouse button as you move the mouse is called dragging.

Drive: A storage area in any storage device is known as drive.

Drop: After dragging, releasing the left mouse button to move an object is called Drop.

DSL is a high speed, digital, always-on Internet technology that runs over standard phone lines.

DVD stands for digital versatile disc; it is a storage device.

Ellipse enables a user to make ellipses.

Fast forward and rewind buttons are used to control the speed of the audio/video file.

File is a collection of data that is stored on a computer.

Floppy disk is a portable and inexpensive storage device.

Folders are like envelopes or drawers in which a user can place files and folders.

Fonts: The set of letters, numbers or symbols of a specific design which can be displayed or printed.

Foreground color is the color that the pencil draws with.

Hard disk is a permanent storage device of the computer. It is an inexpensive, reliable and durable storage device. It is fixed inside the system unit.

Hardware refers to all physical parts of a computer that a user can see and touch.

Home keys: A S D F and J K L; are called home keys.

Home Page: The very first page of the Web site is known as Home Page.

Icons are small images that represent different types of programs and files.

Information: Data after processing is called information.

Input devices: Devices that are used to enter data into a computer are called input devices.

Input Operation: The operation in which a computer accepts data and instructions for processing from input devices is known as input operation.
Internet is the largest network of computers around the world. 

ISP: A company which provides an Internet connection is called ISP.

Keyboard is most commonly used input device. It allows user to type words, numbers or symbols into a computer.

Line tool is used to draw straight lines of different colors and thickness.

Maximize button is used to enlarge a window to full screen

Media Player is a software which plays audio and video files.

Memory is the electronic holding place. It stores instructions and data that the computer’s processor can access.

Menu bar of a window contains different menus such as File, Edit, View, Favorites, Tools and Help.

Microphone is an input device. It is used to record voice in the computer.

Microsoft Office Button provides fast access to files and frequently used commands.

Microsoft Internet Explorer: In Windows, the software which serves as a web browser is known as Microsoft Internet Explorer.

Microsoft Paint is a graphics software. It is used to draw and edit images.

Microsoft windows is the software which provides a platform to work on a computer.

Minimize button reduces a window to a button on the task bar.

Modem is a device which is used to connect and communicate with other computers.

Monitor is an output device. It displays information on the screen.

Motherboard is the largest circuit board in the computer. All the computer components are plugged or connected with it.

Mouse is an input device that enables a user select commands quickly and perform tasks.

My Computer icon gives access to all disk drives and other hardware connected to the computer.

My Documents folder is used to save documents such as letters, reports, pictures and media files.

Notification Area: The area at the bottom right on the screen is known as notification area.

Output devices: Devices that show output are called output devices.

Output operation: In this operation, the computer uses output devices to produce the results of the processing (information).

Pencil tool is used to draw freehand drawing. However, the thickness of the line cannot be adjusted with this tool.

Printer is an output device. It gives output on the paper.

Processing operation: The operation in which a computer performs some action on the data according to the instructions is known as processing operation.

Processor is the brain of the computer. It is made of the silicon chips fixed on the motherboard. It converts data into information. It is also known as CPU.

Quick Access Toolbar holds the commands which are frequently used.

QWERTY row: the row above the home row is called QWERTY row.

Rectangle tool is used to make rectangles.

Recycle Bin is the place where Windows stores deleted files.

Ribbon presents commands organized into a set of tabs.

Scanner is used to scan text and images into a computer.

Scroll bar is used to view all contents of a window vertically and horizontally.

Search Engine is a program that is used to find web pages and websites.

Software is the set of instructions given to the computer to perform a specific task.

Speakers are output devices. They allow a user to hear sounds from the computer.

Start button displays a list of items called Start Menu.

Status bar gives information about the window and its contents.
Stop button is used to stop any file playing in media player.

Storage devices hold data, instructions and information permanently.

Storage operation: In this step, the computer stores the output permanently on different storage devices such as Hard Disk, Floppy disk, CD/DVD and USB Flash drive.

System unit is a box where processing takes place. It consists of main circuit board, processor, power supply and storage devices.

Taskbar is placed at the bottom of the screen in the Microsoft Windows. It includes Start button, Quick launch toolbar, Task bar buttons and Notification area.

Text case: A user can change the selected text to UPPERCASE, lowercase or other common capitalizations.

Text editing: Adding, removing and re-arranging text in the document is called text editing.

Text tool creates a text frame in which a user can choose the font, size and style to type.

Text Style: To emphasize information in the document, a user can make the text bold, italicized or underlined.

Title bar: Horizontal bar at the top of a window is known as Title bar.

Toolbar contains different command buttons with their icons so a user can easily access these commands.

Typing Tutor is a software that helps a user to learn and improve typing skills.

USB Flash memory is a storage device. It is a portable, expensive, reliable and durable storage device.

URL (Uniform Resource Locator) is the address of a web page on the Internet.

Volume slider is used to control volume level of the audio/video file.

Web browser is a software which is used to access and view different websites.

Web page is a document on the World Wide Web. It can contain text, graphics, audio, videos and links to other pages.

Window is a rectangular area on the computer in which applications or documents are viewed.

Website is a collection of related Web pages. Each website contains a number of documents and files.

World Wide Web is the collection of web pages on the Internet.

---

**Bibliography**

<table>
<thead>
<tr>
<th>Title of Website</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wikipedia</td>
<td><a href="http://www.wikipedia.com">www.wikipedia.com</a></td>
</tr>
<tr>
<td>Webopedia</td>
<td><a href="http://www.webopedia.com">www.webopedia.com</a></td>
</tr>
<tr>
<td>TypingMaster</td>
<td><a href="http://www.typingmaster.com">www.typingmaster.com</a></td>
</tr>
<tr>
<td>Answers.com</td>
<td><a href="http://www.answers.com">www.answers.com</a></td>
</tr>
<tr>
<td>HowStuffWorks</td>
<td><a href="http://www.howstuffworks.com">www.howstuffworks.com</a></td>
</tr>
<tr>
<td>Hotmail</td>
<td><a href="http://www.hotmail.com">www.hotmail.com</a></td>
</tr>
<tr>
<td>Google</td>
<td><a href="http://www.google.com">www.google.com</a></td>
</tr>
<tr>
<td>MSN</td>
<td><a href="http://www.msn.com">www.msn.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title of Book</th>
<th>Author/Publisher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Concepts</td>
<td>Parsons and Oja</td>
</tr>
<tr>
<td>Introduction to Computers</td>
<td>Peter Norton</td>
</tr>
<tr>
<td>Discovering computers 2009</td>
<td>Shelly Cashman</td>
</tr>
<tr>
<td>Computer Applications</td>
<td>Pearson Longman</td>
</tr>
<tr>
<td>Computer Basics for Kids</td>
<td>Usman Mushtaq</td>
</tr>
<tr>
<td>Computing Studies</td>
<td>G. K. Powers</td>
</tr>
</tbody>
</table>
Index

A
Accuracy 4
Address Bar 125
Airbrush Tool 62, 67
Alta Vista 127
Alt Key 8
Arrow Keys 8
Ask Jeeves 127
Auto Hide Menu Bar 99

B
Background Colors 62
Backspace Key 8
Bold 91
Brush Tool 62, 63, 66
Buttons 8

C
Cable Modems 118, 119
Caps Lock Key 8
CD (compact disc) 15
Center Align 93
Chatting 118
Click 9
Close Button 39, 40, 62, 82
Color Palette 62
Command Buttons 39, 40
Communication Devices 18
Computer 1, 2
Copy and Paste 87, 88
CPU 12
CRT Monitors 16
Ctrl Key 8
Curve Tool 62, 63
Cursor Control Keys 7
Cut and Paste 87

D
Data 3
Delete Key 8
Deleting Text 87
Desktop 32
Desktop Icons 34
Dialogue Box Launcher 84
Dial-up Modems 118, 119
Digital Camera 10
Digital Subscriber Line 118, 119
Dot Matrix Printer 17
Double Click 9
Dragging 9
Drawing Tools 62
Drive 43
DVD (Digital Video Disc) 15

E
Education 118
Ellipse Tool 62, 67
E-mail 117
End Key 7, 8
Enter Key 7, 8
Entertainment 118
Eraser Tool 62
Escape Key 8
External Hard disks 15
External Modem 18, 121
Fast Forward Button 99, 101
File 41
Fill with Color Tool 62, 66
Floppy Disk 14
Folder 41, 42
Fonts 89
Font Size 89
Font Styles 91
Foreground colors 62
Full Justification 93
Function Keys 7

G
Google 127, 130
Groups 84
Group Name 82

H
Hard Disk 14,
Hardware 5, 7
Help 82
Home Key 8
Home Keys 74
Horizontal Scroll Bar 39, 40, 61, 82

I
Information 3
Inkjet Printer 17
Input Devices 6
Input Operation 19, 20
Insertion Pointer 92
Instant Messaging (IM) 118
Internal Modem 18, 121
Internet 115, 116
Internet Explorer 34, 36, 125

K
Keyboard 2, 5, 6, 7

L
Laser Printer 17
LCD (Liquid Crystal Display) 16
Left Align 93
Left Hand Keys 74
Letter keys 8
Line Tool 62, 63
Lower Case 94

M
Magnifier Tool 64
Maximize Button 39, 40, 61, 82
Media Player 99
Memory 17
Memory Chips 12
Menu 119
Menu Bar 39, 40, 61
Microphone 11
Microsoft Paint 5, 60
<table>
<thead>
<tr>
<th>P</th>
<th>Microsoft Office Button 82</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Microsoft Word 8, 81</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 29, 30, 37</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows XP 5</td>
</tr>
<tr>
<td></td>
<td>Minimize Button 39, 40, 61, 81</td>
</tr>
<tr>
<td></td>
<td>Modems 18, 121</td>
</tr>
<tr>
<td></td>
<td>Monitor 2, 5, 17</td>
</tr>
<tr>
<td></td>
<td>Motherboard 11, 12</td>
</tr>
<tr>
<td></td>
<td>Mouse 2, 5, 8</td>
</tr>
<tr>
<td></td>
<td>MSN 127, 128</td>
</tr>
<tr>
<td></td>
<td>MS Word User Interface 82</td>
</tr>
<tr>
<td></td>
<td>Mute Button 100, 101</td>
</tr>
<tr>
<td></td>
<td>My Computer 34, 35</td>
</tr>
<tr>
<td></td>
<td>My Documents 34</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q</th>
<th>Quick Access Toolbar 82</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Quick Launch Toolbar 33</td>
</tr>
<tr>
<td></td>
<td>QWERTY 6, 76</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th>RAM 13</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read/Write Head 14</td>
</tr>
<tr>
<td></td>
<td>Rectangle Tool 62, 87</td>
</tr>
<tr>
<td></td>
<td>Recycle Bin 35, 36</td>
</tr>
<tr>
<td></td>
<td>Refresh Button 125</td>
</tr>
<tr>
<td></td>
<td>Rewind Button 100, 101</td>
</tr>
<tr>
<td></td>
<td>Ribbon 82</td>
</tr>
<tr>
<td></td>
<td>Ribbon Tab 82</td>
</tr>
<tr>
<td></td>
<td>Right Align 93</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th>Scanner 5, 10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scroll Bar 39, 40, 61, 82</td>
</tr>
<tr>
<td></td>
<td>Search Engine 127</td>
</tr>
<tr>
<td></td>
<td>Seek Bar 100</td>
</tr>
<tr>
<td></td>
<td>Select tool 62</td>
</tr>
<tr>
<td></td>
<td>Sentence Case 94</td>
</tr>
<tr>
<td></td>
<td>Shift Keys 8</td>
</tr>
<tr>
<td></td>
<td>Smart Phone 2</td>
</tr>
<tr>
<td></td>
<td>Software 5, 6</td>
</tr>
<tr>
<td></td>
<td>Space Bar 7</td>
</tr>
<tr>
<td></td>
<td>Speakers 2, 5, 17</td>
</tr>
<tr>
<td></td>
<td>Speed 4</td>
</tr>
<tr>
<td></td>
<td>Spell Check and Grammar 95</td>
</tr>
<tr>
<td></td>
<td>Spindle 14</td>
</tr>
<tr>
<td></td>
<td>Start Button 32</td>
</tr>
<tr>
<td></td>
<td>Start Menu 32, 33</td>
</tr>
<tr>
<td></td>
<td>Status Bar 39, 40, 61, 82</td>
</tr>
<tr>
<td></td>
<td>Stop Button 100, 125</td>
</tr>
<tr>
<td></td>
<td>Storage 4</td>
</tr>
<tr>
<td></td>
<td>Storage Devices 14, 20</td>
</tr>
<tr>
<td></td>
<td>Storage Operation 19, 20</td>
</tr>
<tr>
<td></td>
<td>Super Computer 2</td>
</tr>
<tr>
<td></td>
<td>System Unit 2, 11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
<th>Tab 125</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Tab Key 8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th>Taskbar 33</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Telephone Modems 118, 119</td>
</tr>
<tr>
<td></td>
<td>Taskbar Buttons 33</td>
</tr>
<tr>
<td></td>
<td>Text Alignment 93</td>
</tr>
<tr>
<td></td>
<td>Text Editing 85</td>
</tr>
<tr>
<td></td>
<td>Text Selecting 87</td>
</tr>
<tr>
<td></td>
<td>Text Tool 62, 69</td>
</tr>
<tr>
<td></td>
<td>The Web 122</td>
</tr>
<tr>
<td></td>
<td>Title bar 39, 40, 61, 82</td>
</tr>
<tr>
<td></td>
<td>Title Case 94</td>
</tr>
<tr>
<td></td>
<td>Toggle Case 94</td>
</tr>
<tr>
<td></td>
<td>Toolbar 39, 40, 82</td>
</tr>
<tr>
<td></td>
<td>Toolbox 61</td>
</tr>
<tr>
<td></td>
<td>Typewriter Keys 7</td>
</tr>
<tr>
<td></td>
<td>Typing 74</td>
</tr>
<tr>
<td></td>
<td>Typing Tutor 74, 77</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V</th>
<th>URL 123</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Upper Case 94</td>
</tr>
<tr>
<td></td>
<td>USB Flash Memory 16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>W</th>
<th>VDU (Visual Display Output) 16</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Verstalilty 4</td>
</tr>
<tr>
<td></td>
<td>Vertical Scroll Bar 39, 40, 61, 82</td>
</tr>
<tr>
<td></td>
<td>Views 96</td>
</tr>
<tr>
<td></td>
<td>Volatile Memory 12</td>
</tr>
<tr>
<td></td>
<td>Volume Slider 100, 101</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y</th>
<th>Web Browser 121, 124</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Web Page 123</td>
</tr>
<tr>
<td></td>
<td>Website 123</td>
</tr>
<tr>
<td></td>
<td>Wheel 8</td>
</tr>
<tr>
<td></td>
<td>Window 39</td>
</tr>
<tr>
<td></td>
<td>Windows Media Player 100</td>
</tr>
<tr>
<td></td>
<td>World Wide Web 118, 122</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Z</th>
<th>Yahoo 127, 129</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom Slider 82</td>
</tr>
</tbody>
</table>
Exercise is essential for the body; it makes us feel good all through the day.

Clip your nails on time so that dust does not get stuck in them. Also, wash your hands and feet regularly.
This textbook has been selected and distributed by Government of Punjab Academic year 2018-19 as textbook for all Government School in Punjab

Aquiline Publishers
9-A Circular Road, Urdu Bazar, Lahore.
Email: aquilinenpub@gmail.com
Ph: +92-42-37320713